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Preface 
This text is focused on the students of the subject “CAD design in landscape engineering” at 

Slovak University of Agriculture in Nitra. Currently there is variety of software, view and editing in 

CAD environment – “Computer Aided Design”. One of the most frequently used are products of the 

company Autodesk, which are used in various branches of industry that require the production of 

simple drawings, possibilities of 3D design, but also analyses and various statistics. 

This publication is focused on the use of basic software AutoCAD, its settings, most 

common functions and commands, but also description and solving of tasks that experts from the 

programme “Landscape engineering” face in the practice. This text is not focused on the basic skills 

in software AutoCAD. 

Exercises that are solved in this text will be available for the students in the system 

MOODLE of Slovak University of Agriculture in Nitra. 

5



Coordinate systems and units in the CAD environment 

Drawing units 
When working in the AutoCAD environment, we can see two basic units – the length units 

and the angular units. Depending on the requirements on the drawing documentation, it is therefore 

necessary to take into account the units – the work with the drawing with meters will be different 

than the work with the drawing of the ground plan of a building using millimetres. It is also 

necessary to take into account the work where we will require angular units in decimal degrees, in 

the units: degree – minute – seconds, in radians or in grades. The drawing units are managed using 

the “UNITS” command, which opens a dialogue box where you can set the individual parameters of 

the drawing units.  

Fig. 1: Window for the setting of unit parameters: 1 – type and accuracy of length; 2 – type and accuracy of angles; 
3 – drawing units for content insertion; 4 – units for lights 

The setting of units of length and angle are taken into account in the current drawing and are 

not transferred into other drawings, but the settings of the drawing units (Fig. 1 – 3) affect the 

combination of designs from multiple drawings – whether during the transfer of blocks between 

drawings or when external references are added. This is discussed in detail in Chapter “Using 

blocks in multiple drawings”. 
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Table 1: Units of length 

Type Description Accuracy Example: Length value 
22.5 

Architectural Whole feet and 
inches 

Whole inches up to 1/256 
of the inch 1'-10 1/2" 

Decimal Decimal units 0-8 decimal digits 22.500 (accuracy - 3 
thousandths) 

Engineering Whole feet and 
inches 

0-8 decimal digits of the 
inch 1'-10.5" 

Fractional Integral number and 
fragment 

Integral number up to 
1/256 of the unit 22 1/2 

Scientific Exponential 0-8 decimal digits 2.250E+01 

Table 2: Angular units 

Type Accuracy Example: Angular value 12.5 
Decimal 
degrees 0-8 decimal digits of the degree 12.5 

(accuracy – one tenth) 

Deg/Min/Sec Whole degrees up to 4 decimal 
digits of the second 

12d30'0" 
(accuracy – whole seconds) 

Grades 0-8 decimal digits of the grade 13.889g 
(accuracy – 3 thousandths of the grade) 

Radians 0-8 decimal digits of the radian 0.218r 
(accuracy – 3 thousandths of the radian) 

Cardinal 
directions 

Whole degrees up to 4 decimal 
digits of the second 

N 77d30'0" E 
(accuracy – whole seconds) 

It is necessary to take into account that the setting of the unit system or of their accuracy is 

then reflected in several aspects such as object properties or value measurement such as angles, 

lengths, areas or volumes. But this setting does not affect the accuracy of displaying the length or 

angles values in the dimensions – this accuracy is solved by the setting of the dimensioning styles 

(Fig. 2).  
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Fig. 2: Showing the lengths and angles when setting accuracy to an integral number (on the left) and to four decimal 
places (on the right), 

1 – line length; 2 – line angle; 3 – coordinates of the starting and ending points of the line 
Note -the values of the length and angle dimensions remain the same in both cases because the setting of the length 

(4 decimal places) and angles (integer) accuracy is solved by the setting of the dimensioning style 

S-JTSK coordinate system in the AutoCAD environment 
The drawing documentation for landscape planning often requires an elaboration in the 

S-JTSK coordinate system for sequential demarcation using geodetic methods in the terrain, for 

example the demarcation of the layout of surface objects (e.g. fuel station, reinforced surfaces) or 

the routes of line objects (road axis, banks of the revitalized watercourse channel), as well as the 

retrospective marking of the measured values for the planimetry and topography (terrain relief, land 

borders), localized geodetically. But there is a problem between the S-JTSK coordinate system and 

the coordinate system of the AutoCAD system during the demarcation of objects formed by a series 

of points with known coordinates. 

In the AutoCAD program, the axis orientation is as follows: 

- the values on axis x go from left to right (from west to east), 

- the values on axis y go from the bottom up (from south to north). 

In the S-JTSK coordinate system, the axis orientation is as follows: 

- the values on axis x go from top to bottom (from north to south), 

- the values on axis y go from right to left (from east to west). 

For this reason, during the completion of these tasks, the coordinates are corrected in two 

steps: 

1. the numeric value of the coordinate is given in a negative form,

2. the axes x and y are interchanged.
8



For example, the coordinate of the point – the entry to the premises of the Department of 

Landscape Planning: 

S-JTSK coordinates: X= 1268052; Y= 498742 

AutoCAD coordinates: X= -498742; Y= -1268052 

This correction does not change the mutual spatial relationships – the distance between the 

two objects and their mutual position is the same. At the same time, it is ensured that the 

construction, or its parts marked in the drawing documentation can then be geodetically 

demarcated. 

The usual task is to insert the drawing of the construction, which is prepared in a separate 

drawing in millimetres, which is the standard in the project documentation of buildings, into 

a drawing of the situation prepared in the S-JTSK coordinate system. In this case, we work with two 

or more drawings that are prepared in different units: 

- the situation drawing in S-JTSK prepared in metres, 

- the documentation of the construction prepared in millimetres. 

The insertion of the construction drawing into the situation drawing and its subsequent 

geodetic demarcation in the terrain therefore requires a change in the scale of the construction 

drawing and the subsequent insertion and fitting into the situation drawing. The transfer of the 

entities between the drawings can be done by using several commands such as: 

- The cutting of the objects – the command “CUTCLIP” (or the shortcut Ctrl + X) – it cuts 

the object from the original drawing into a clipboard, the coordinates of the reference 

point are [xmin,ymin] – the smallest x as well as y coordinates of the cut objects. 

- The copying into the clipboard – the command “COPYCLIP” (or the shortcut Ctrl + C) – 

it copies the object from the original drawing into a clipboard, the coordinates of the 

reference point are [xmin,ymin] – the smallest x as well as y coordinates of the cut objects. 

- The copying into the clipboard through a reference point – the command “COPYBASE” 

(or the shortcut Ctrl + Shift + C) – it copies the object from the original drawing into the 

clipboard, the reference point has the coordinates according to the entered point (using 

the keyboard for entering its coordinates or by selection – clicking on the required 

point). 

The insertion of an object into the drawing is done by using the command “PASTECLIP” (or 

the shortcut Ctrl + V) that inserts the transmitted object grabbed at the reference point (depending 

on the entity transfer method that is being used) to the insertion point that we enter using the 

coordinates or by clicking on the desired location. 
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Note: The greatest control over the copying and then the insertion of the objects into 

a drawing is provided by the method of copying to the clipboard through a reference point as the 

user chooses which point to consider as a reference one when copying, and because of that this 

method of transferring objects is described below. 

When transferring a construction object into a drawing, it is advisable to first create a copy 

of the floor plan, then reduce the copy using the command “SCALE” command in the required ratio 

(from 1/1,000 or 0.001mm from millimetres to meters). By copying to the clipboard through 

a reference point, the reduced design is copied into the drawing where it will then be fitted into the 

desired position, respecting the requirements such as the street line, linking to the desired objects, 

respecting the protection zones, and so on. This object can then be demarcated geodetically using 

the coordinates which we can already precisely read from the situation drawing. 

The solution of this type of task will be demonstrated in the example of the layout of 

a pumping station (PS) into the terrain. The station should pump the water from the drainage 

channel “C” into the Radošinka stream. The task is to find a suitable place for the PS and to identify 

the points for the demarcation of the construction. The corners of the construction are, at the same 

time, the corners of the foundations to be geodetically defined in the terrain. The background 

documents are: 

- the drawing of the pumping station floor plan with the marking of the suction and 

discharge pipes in millimetres (Fig. 3), 

- the situation drawing prepared in meters and in S-JTSK – drawn earth bodies, the 

watercourse channel, the drainage channel and the route of the track (Fig. 4), 

- the drawing of the overhead electrical line – 110 kV voltage – prepared in metres and in 

S-JTSK (Fig. 4) 

Fig. 3: Floor plan of the pumping station 
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Fig. 4: Situation drawing (on the left); drawing of the electric line route (on the right) 

The moving of objects between the drawings in the same coordinate system – UCS (UCS = 

User Coordinate System) and in the same units when we need to insert the object in the same place 

– i.e. in case of a model example, the copying of the route of the electric line into its identical 

position in the situation drawing – both drawings are prepared in meters and in S-JTSK, we use 

copying using the method of copying into the clipboard through a reference point, where the 

identical points in both drawings are the beginnings of the coordinate systems – the point with the 

coordinate [0,0,0]. In the drawing of the route of the electric line, we use the command 

“COPYBASE” (or use the shortcut Ctrl + Shift + C), we enter the coordinates of the beginning – 

0,0,0 - as the reference point – into the command line and select the copied objects – the route of the 

electric line and the position of the poles of the electric lines. Then, in the situation drawing, we 

insert the objects in the clipboard (the route and the poles) to the identical point – we use the 

command “PASTECLIP” (or shortcut Ctrl + V) and we select the beginning of the UCS with 

coordinates 0,0,0 as the insertion point – we enter them into the command line. 

In case of moving the drawing of the pumping station floor plan, which is created in 

millimetres, into the situation drawing prepared in S-JTSK in meters, we must first ensure the 

change of the units for the PS floor plan from millimetres to meters. The conversion is done by 

reducing the copy of the object to one-thousandth of the original dimension: the PS object with the 

dimensions 20,000 (mm) x 10,000 (mm) PS object will have the dimensions of 20 (m) x 20 (m). In 

case of texts, their height is reduced to a multiple of the scale value – to one thousandth of the 

original height of the text; in case of the dimensions, the dimensions are reduced, and therefore the 

dimension text, but the size of the dimension text, as well as the dimension arrows have the 

dimensions according to the original dimension style. Therefore, it is necessary to change the style 
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of the created dimensions, or to remove the existing dimensions and to create new dimensions in the 

style applicable to the objects created in metres. We copy the reduced object to the clipboard 

through a reference point using the command “COPYBASE” (or shortcut Ctrl + Shift + C), which is 

selected by clicking on the screen – for example, one of the corners of the object. In the situation 

drawing, we insert the copied objects – we use the command “PASTECLIP” (or shortcut Ctrl + V) 

and we enter the insertion point – it can be entered by using coordinates, but since the position of 

the object layout is not known, it is sufficient to insert the object into any position in the drawing – 

the insertion point is selected by clicking (Fig. 5). 

Fig. 5: Insertion of the drawing of the pumping station into the situation drawing 

There is no need to reduce the objects when inserting the design of the route of the electric 

line, as the situation drawing and the drawing of the route of the electric line are prepared in meters. 

Since both drawings are prepared in S-JTSK, their position in the drawings corresponds to the 

actual geographic position and therefore the spatial relations between the objects in the two 

drawings are identical. In this case, we use the copying of the objects from the drawing of the 

electric line into the clipboard and insert them into the situation drawing. During copying and 

insertion, as a point of reference, we select a point that is identical in both cases, and that is the 

point with the coordinate [0,0,0]. 

Then we fit the floor plan object into a suitable place using basic geometric operations such 

as moving and rotating. In case of fitting of the situation, we take into account the railway 

protection zones (60 m from the axis of the outer track – according to the Act No. 513/2009 Coll.) 

and the routes of the overhead electrical lines – 110 kV (defined by vertical planes on both sides of 

the line at a horizontal distance of 15 m measured perpendicularly from the outer conductor at 

a voltage from 35 kV to 110 kV including – according to the Act No. 656/2004 Coll. on the energy 

sector) – we write these conditions into the drawing using the command “OFFSET”, by which we 

create lines in the relevant distances according to the object in question, i.e. 15 m from the outer 

electric conductor and 60 m from the outer track (Fig. 6). If the solution of the fitting requires the 
12



respecting of other rules (such as street lines, the rights of property – land borders, other protection 

zones, economic considerations – e.g. the shortest distances, operating parameters – connection to 

the withdrawal objects or other circumstances), we also take these rules into account.  

Fig. 6: Final position of the pumping station, respecting the protection zones of the railway as well as the electric line 

Creating a new coordinate system 

Any manipulation of the drawing content (such as rotating or moving objects for better 

fitting into the drawing format when printing) made in the S-JTSK coordinate system results in 

a change in the position of the displayed objects, making it impossible for the construction to be 

demarcated. 

The need to display the rotated drawing content can be solved by creating a new coordinate 

system that will then be used when displaying in the required in the desired cut-out (Viewport) 

using the setting of the drawing sheet (Layout), or the description of the drawing (corner stamp, 

key, notes, etc.) will be created in the rotated UCS which is set to current when printing and is 

displayed in the Cartesian system (see the drawing viewport in the chapter “Advanced print 

options”). 

To work with the coordinate systems, the “Coordinates” (Fig. 7) panel of the coordinate 

systems is used on the “View” tab in the 3D modelling work environment or the “Home” tab in the 

3D Basics work environment. This panel is not normally displayed in the Drafting & Annotation 

environment. To display it, you must right-click the “View” tab and select the “Show Panels” option 

and then select the “Coordinates” panel. 

The whole process of making a new UCS should be started with the program setting 

(Fig. 7 – 2) so that when you change the coordinate system, a view perpendicular to the plane of the 
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floor plan (XY plane) is set, so the creation of the new UCS will result in its automatic setting to the 

current one and the drawing will be immediately displayed so that the axis x will be horizontal and 

the axis y will be vertical. This setting can be done in the coordinate systems manager using the 

command “UCSMAN” or “DDUCS”, or by using the icons on the “Coordinates” panel. 

Fig. 7: UCS setting. 1 – opening if the dialogue box on the “Coordinates” panel; 2 – setting the view perpendicular 
to the plane of the floor plan 

A new UCS can be created in several ways: 

- Setting according to the area of the 3D object 

- Setting according to the object 

- Setting according to the current view 

- Rotating the current UCS round the selected axis 

- Defining the new beginning 

- Defining by using three points 

For the purpose of the UCS rotation, it is best to use the definition of a new UCS using three 

points where the first point is the new beginning of the coordinate system, the second point is the 

designation of the positive part of the new axis x, and the third point is designation of the positive 

part of the new axis y. The axis z will be determined automatically according to the orientation of 

the Cartesian system (axis x – positive in the right direction, axis y – positive in the upward 

direction, axis z in the direction above the XY plane). When using this method, it is then 

appropriate to select a new orientation of the axes to suit the requirements of the drawing display in 

the desired rotated display. Before creating a new UCS, it is a good idea to first create the north star 

that, after the definition of the new UCS and the rotation of the display, allows better orientation in 

the final drawing.  
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A practical example will be demonstrated in a simple task – printing of a schematic situation 

of the Radošinka stream at the bridge of the road to the village of Čakajovce, this situation should 

be printed in a scale of 1: 5,000 on A3 format, but without the rotation of the drawing it is not 

possible to place it in the selected format - the size of the design is larger that than the height of the 

paper size (Fig. 8). 

Fig. 8: Situation of the Radošinka stream 

Prior to creating a new system, we select the setting of the view perpendicular to the plane 

of the floor plan, and the creation of a new coordinate system is then started using the following 

procedure: 

1. the command “UCS”

2. in the command line, we select the option “n” – the creation of a new coordinate system

3. in the command line, we select the option “3” – the creation of a new coordinate system

using three points: point no. 1 is the beginning of the new coordinate system; point no. 2

is on the positive part of the new axis “X”; point no 3 is on the positive part of the new

axis “Y” (Fig. 9)

Fig. 9: Creation of a new coordinate system using three points, 1 – beginning of the new coordinate system; 2 – a 
point on the positive part of the new axis “X”; 3 – a point on the positive part of the new axis “Y” 
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The new coordinate system created in this way displays the existing drawing in a rotated 

status as we have chosen the setting of a view perpendicular to the plane of the floor plan (Fig. 10). 

Fig. 10: Drawing with the new coordinate system with the setting of a view perpendicular to the plane of the floor 
plan 

If we did not initially select the setting of a view perpendicular to the plane of the floor plan, 

the display of the whole drawing would remain oriented in terms of the Cartesian coordinate system 

without any change, and the coordinates, or the cross line of the cursor would  take into account the 

new coordinate system (Fig. 11). 

Fig. 11: Drawing with the new coordinate system without the setting of a view perpendicular to the plane of the floor 
plan 

The coordinate system created in this way should be then named in the coordinate system 

manager (Fig. 12), since the newly created and named co-ordinate system remains stored in the 

particular drawing.  
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Fig. 12: Naming and selecting the current coordinate system in the message window of the coordinate systems 

The use of the newly created coordinate system means that the existing objects as well as the 

newly created objects will have the coordinates and angles measured relative to the current 

coordinate system (Fig. 13).  

Fig. 13: Coordinates of a point in different coordinate systems, 1 – coordinates of point A in the S-JTSK coordinate 
system, or “World”; 2 – coordinates of point A in a rotated, newly created coordinate system 

but there is a difference in the parameters displayed in the property table (in English: 

Properties) where the coordinates of the objects will be given with respect to the current coordinate 

system, but the angles will be given relative to the “World” coordinate system. In the given example 

(Fig. 14), the command “MEASURE” and the option “A” (angle) were used to measure the angle 

between the red lines – the value of the angle is 52°, but the line drawn at that angle shows an angle 

of 349° in the property table – this angle is formed by this line in the “World” coordinate system, it 

is therefore showed in the properties table. 
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Fig. 14: Determining the value of the angle, 1 – the value of the angle showed in the properties table (in English: 
Properties); 2 – the value of the angle measured by an angle measuring tool 

In this way, it is possible to place the design in a suitable way in the drawing so that the 

format of the drawing with descriptions, corner stamp, key and other drawing requirements is 

inserted horizontally, or vertically in a newly created, rotated coordinate system. If the S-subtraction 

or determination of the coordinates in S-JTK is required, the drawing is displayed in the S-JTSK 

coordinate system and the required coordinate detection is performed in the drawing displayed in 

this way (Fig. 15). 

Fig. 15: Use of the newly created coordinate system – displaying the design and the coordinates in the S-JTSK 
coordinate system (on the left) and the rotated coordinate system (on the right) 
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External references 
Using several drawings as well as using background documents of other formats (raster 

graphics, background documents in *.dgn format and other) in the existing design can be solved by 

using external references from various types of files (DWG, DWF, raster graphics, PDF, clouds of 

points, DGN).  

The main function of the external references is the use of multiple background documents 

and their management. A typical example is the work of multiple users on a single project, 

consisting of several drawings with different contents – a situation drawing where the proposed 

elements are gradually inserted, as well as the filling of the existing status data (additional geodetic 

measurements of the topography, drawing of the line routes, of the protection zones and so on). The 

difference, compared with the combination of elements by inserting from another drawing, is that 

when changing the contents of an external reference drawing, this change is also reflected in the 

target drawing in which the external reference is inserted.  

The use of external references will be explained in the drawing of the Radošinka stream 

(units: meters, drawing in S-JTSK). First, the drawing of the electric line (units: meters, drawing in 

S-JTSK) will be attached. Subsequently, two drawings will be added to the situation drawing of the 

pumping station - additional geodetic demarcation of the planimetry and the topography of the 

terrain (units: meters, drawing in S-JTSK) and the drawing of the pumping station floor plan (units: 

millimetres). Finally, the drawing of the access road to the pumping station (units: meters, drawing 

in S-JTSK) will be attached, to which the drawing of the bridge through the channel “C” will be 

attached (units: millimetres). 

19



Fig. 16: Scheme of the attachment of the particular external references to the situation drawing of the pumping 
station 

External references and units of the drawing 
At work, for each drawing, it is necessary to correctly set the drawing units when inserting 

the content, which ensures the conversion of the dimensions between the drawings prepared in 

different units. With this setting, we ensure that, for example, a pumping station with the 

dimensions of 20,000 x 10,000 unit will represent a size of 20,000 x 10,000 millimetres, which will 

automatically be converted to 20 x 10 units when inserting this drawing as an external reference 

into the situation drawing prepared in metres, that is, 20 x 10 metres and not to the original 20,000 x 

10,000 units, which would be 20,000 x 10,000 meters without setting the units in the situation 

drawing. 

Attaching the external references 
The attaching of the external references is done by using the command “ATTACH”, or the 

attachment is possible only using the pallet of external references that we can open on the “Pallets” 

panel on the “View” tab, or on the “Reference” panel on the “Insert” tab, or by using the command 

“XREF”, or “EXTERNALREFERENCES” (Fig. 17).  
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Fig. 17: Attachment of the external references to the drawing, 1 – attachment of the external references using 
a pallet of external references; 2 – opening the pallet of external references on the “Reference” panel on the “View” tab; 

3 – attachment of the external references using the button ATTACH on the “Insert” tab on the “Reference” panel; 
4 – opening the pallet of external references on the “Reference” panel on the “Insert” tab 

The drawing of the electric line will be the first to be inserted. Since the units in both 

drawings are identical (meters), it is not necessary to perform the scale change – the scale in the 

axes x, y, z will remain to be set to (Fig. 18 – 1). The drawings of the situation as well as the 

electric lines are prepared S-JTSK and in metres, so they both have the same beginning of the 

coordinate system – the point with a coordinate [0,0,0], so we can use this point as an insertion 

point (Fig. 18 – 2). So the software inserts the external reference – the drawing of the electric line 

into the target drawing at a point with the coordinate [0,0,0] so that the basic insertion point of the 

external reference (by default, set to the point with the coordinate [0,0,0]), inserted at the coordinate 

[0.0.0] of the target drawing). The rotation angle remains at the value of “0” – it is not necessary to 

rotate the external reference because the situation and the drawing of the electric line display their 

contents in the real geodetic position in the S-JTSK coordinate system (Fig. 18 – 3).  

When selecting the reference type (Fig. 18 – 4), there are two options: 

- Attachment – the attached external reference becomes an attachment of the target 

drawing, if the entire target drawing is attached to the next drawing, the external reference attached 

to the target drawing will be attached, besides the design of the target drawing. 

- Overlay – the attached external reference becomes only a background for the target 

drawing, if the entire target drawing is attached to the next drawing, only the design of the target 

drawing will be attached, without the external reference. 

When selecting the access road, it is best to select a relative access road (Fig. 18 – 5), as it is 

possible, when moving the whole folder with the drawing and the external reference, to immediately 

display the reference, without having to re-search it and attach it – the program takes the partial 
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hierarchy of the folders specified as a path (e.g. \Publikacie\Skripta_CAD\xref\2cerpacka_elektro.dwg ), 

it will start the search from the folder higher than the home directory of the drawing, and then it follows 

the specified directory structure). Other path types are a full path – Full path (written if the whole path 

to an external reference file, e.g. D:\Publikacie\Skripta_CAD\xref\2cerpacka_elektro.dwg) or no path – 

No Path (the program will search for an external reference file in the default browse of the folders). 

Fig. 18: Window for the attachment of an external reference. 1 – insertion scale; 2 – insertion point; 3 – rotation 
angle; 4 – reference type; 5 – path type 

The attached external reference is then displayed in the drawing. By default, the colour of 

external reference objects is displayed in reduced tones (Fig. 19), making them relatively easy to 

visually distinguish from other objects – but this colour change does not occur when printing. 

Fig. 19: External reference of the electric line inserted into the situation drawing. 1 – route of the electric line; 
2 – objects of the situation drawing 
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The rate of the colour fading is expressed in percentages from 0 to 90 (the default setting is 

50), and it is determined by the variable “XDWGFADECTL”, which can be started using the 

command line and entering a new value or setting the colour fading using the slider, or by entering 

the percentage value on the “Reference” panel on the “Insert” tab (Fig. 20). 

Fig. 20: Setting of the colour fading of the external reference on the “Reference” panel on the “Insert” tab, 1 – 
using the slider; 2 – by entering a numerical value 

Management of the external references 
The basic tasks of the external reference management can be performed in the external 

reference palette and they include the following tasks: 

- Unload – Unloads the linked reference so it will not be displayed but will not be 

removed from the drawing. 

- Reload – Restores the linked reference after changing it in the drawing or reloads the 

released reference. 

- Detach – Detaches the external reference and removes it from the drawing so it cannot 

be reloaded using the references management. The reference drawing is re-inserted if 

necessary, together with the setting of all parameters. 

- Bind – The content of the external reference is moved into the target drawing, and the 

external reference is then detached. Any changes in the drawing of an external reference 

will no longer be displayed in the target drawing from that moment. The binding of the 

type “Bind” will ensure that the blocks in the drawing of an external reference are 

renamed in the format “name_of_external_reference“$n$“name_of_block”. The binding 

of the type “Insert” ensures that the blocks in the drawing of an external reference will 

have the same name as in the drawing of an external reference. If a block with the same 

name already exists in the target drawing, the block definition will be used 

automatically, and the new blocks from the external reference file will be inserted 

according to the block definition from the target drawing. 

- Type of the external reference – Allows to specify whether the reference should behave 

as an Attachment or as an Overlay. 
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Displaying the changes in the external references 
The changes in the drawing of an external reference occur after the drawing of an external 

reference has been saved and re-loaded in the target drawing without the need for deleting and re-

adding the changed drawing of an external reference. This functionality will be shown in an 

example of adding results – points of the geodetic measurement of points at the watercourse near 

the pumping station. 

The file containing the additionally measured topography points is prepared in S-JTSK and 

its units are meters, and it will be added to the situation drawing which already contains an external 

reference of the electric line (Fig. 21). 

Fig. 21: Attachment of the external reference of the additionally measured points. Points in the drawing of the 
external reference of the additional measuring (on the left); display of the target situation drawing before attaching the 

additionally measured points (on the right). 

The file containing the additionally measured points will be attached in the same way as 

when attaching the route of the electric line (it will be attached as an overlay external reference), so 

the additionally measured points will be displayed in the situation drawing (Fig. 22). 

Fig. 22: Attached external reference. Situation drawing with the attached external reference of the additionally 
measured points (on the left); detail of the view of the attached external reference (on the right); 1 – additionally measured 

points. 
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In practice, however, we encounter situations when, during the works in the particular 

drawings, some changes are made – for example, in the drawing of an external reference other 

additionally measured points are added to the additionally measured points (Fig. 23). 

Fig. 23: Adding other points into the drawing of an external reference of the additionally measured points. Red 
points – original; purple points - added points. 

If a change is made in the drawing of an external reference, and this drawing is saved, the 

program will automatically record the change and reports it in the target drawing by announcing it 

in the lower-right corner of the program as well as in the external reference palette (Fig. 24).  

Fig. 24: Warning on the change in an external reference, 1 – warning in the program; 2 – warning in the reference 
table 

By clicking on the announcement in the program, or by right-clicking on the changed 

external reference in the external reference palette and by selecting the “Reload” option, the changes 

to the external reference will also be displayed in the target drawing (Fig. 25). 
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Fig. 25: Changed external reference. Display of the changed external reference (on the left), detail (on the right); 
1 – added additionally measured points. 

External references and units of the drawing 
In case of combining the drawings prepared in different units, the software automatically re-

calculates the dimensions. In case of the model example in question, the solution of this type of task 

will be demonstrated in the attachment of the external reference of the pumping station floor plan to 

the situation drawing – the situation drawing is prepared in S-JTSK and in meters, and the drawing 

of the floor plan is prepared in millimetres (Fig. 26).  

Fig. 26: Floor plan of the pumping station 

Since the insertion point of the drawing of the floor plan is the point with the coordinate 

[0,0,0], and the situation design is located approximately at the coordinate [-503480, -1263250], it 

is better to insert an external reference at the point specified on the screen, so during the insertion of 

an external reference we select this option (Fig. 27) – another option is to leave the insertion on the 
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point with the coordinate [0,0,0] and move the external reference using the command “MOVE”, or 

enter the exact coordinates in the target drawing. 

Fig. 27: Insertion of an external reference of the pumping station floor plan, 1 – setting the insertion point for the 
selection on the screen 

After the attachment of the external reference into the target drawing (Fig. 28), it is possible to 

manipulate the external reference – rotate and move it into the requested position, while respecting 

the spacing distances mentioned in the previous chapter. 

Fig. 28: Placing the external reference on the point selected on the screen. Placing the external reference on the 
point selected on the screen (on the left) and moving it into the requested position (on the right). 

Layers of the external references 

By attaching the external references, the layers of the external reference are also loaded in 

the target drawing in the format “name of the external reference file|name of the layer in the 
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external reference”. In case there is a layer with the same name in the drawing of an external 

reference as in the target drawing or another drawing attached as an external reference, a different 

layer will be used for each file (Fig. 29). The exceptions are the layers “0” and “Defpoints” that will 

always be listed together in the target drawing, regardless of whether there are objects in them in the 

target drawing or in the drawing of any attached external reference. 

Fig. 29: Layers of the external references, 1 – “thin” layer in the target drawing; 2 – “thin” layer in the drawing 
of the pumping station floor plan; 3 – “thin” layer in the drawing of the route of the electric line 

With the layers of the external references, it is then possible to manipulate the layers of the 

target drawing itself in the same way – to turn on/off, to freeze/unfreeze, unlock/lock, to change the 

colour, type and thickness of the line (Fig. 30).   

Fig. 30: Change to the properties of the layers of the external references, 1 – turning off the “dimension” layer; 
2 – change to the colour of the “thick” layer from green to purple 

The changes to the layer settings made in the drawing of the external reference itself will not 

appear in the drawing, but the creation of a new layer will appear – after reloading the external 

reference, the layer and the objects in it will appear in the target drawing. 
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Setting the base point of the drawing 
The beginning of the current coordinate system of the drawing is set as the base point of 

each drawing – the point with the coordinate [0,0,0]. To change the basic point of a drawing, use the 

command “BASE” and select its new location with the cursor or by entering the numeric value of 

the coordinates. When inserting an external reference of the drawing, the content of this drawing 

will be inserted so that the basic insertion point of the drawing of the external reference will be the 

same as the insertion point of the target drawing that we specify when attaching the external 

reference (Fig. 18 or Fig. 27). 

The practical use of the basic point setting will be explained in the example of the bridge 

above the “C” channel. First, an external reference for the outline of the spatial relations of the place 

where the road crosses the “C” channel is inserted into the drawing of the road – both drawings 

prepared in S-JTSK have the basic point in the coordinate [0,0]. The situation drawing will be 

attached as an external reference of the “Overlay” type. Subsequently, the external reference of the 

bridge, which is prepared in millimetres (the basic point is in the coordinate [0,0]), is added into the 

drawing of the road and it is inserted on the pre-prepared point (Fig. 31). When selecting an external 

reference type, the “Attachment” option is selected – when attaching the drawing of the road to the 

situation drawing, this setting will allow the drawing of the bridge to be automatically attached to 

the situation drawing as a separate external reference. The correctly set drawing units ensure the 

conversion, or change of the scale of the external reference to the units of the target drawing, which 

means that the external reference – the drawing of the bridge (drawn in millimetres), with the 

dimensions of 17,000 (mm) x 11,000 (mm), is displayed as an object with the dimensions of 17.0 

(m) x 11.0 (m) in the target drawing of the road (prepared in meters in S-JTSK).  

Fig. 31: Drawing of the road with the attached external reference of the situation (on the left), attachment of the 
drawing of the road (on the right) 
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If it is necessary to change the basic insertion point in the drawing of the bridge, the 

command “BASE” is used and the new basic insertion point is selected by the cursor or by entering 

its coordinates. After reloading the external reference in the target drawing, the design of the 

external reference is displayed, taking into account the changed basic insertion point (Fig. 32). 

Fig. 32: Change of the basic insertion point. original basic point (at the top on the left); changed insertion point (top 
right); displaying the change of the setting of the basic insertion point in the drawing of the bridge (at bottom). 

External reference of the “Attachment” type 

By using the external reference of the “Attachment” type, it is ensured that if we attach 

a drawing with an attached external reference of the “Attachment” type, this external reference will 

be attached with the drawing (Fig. 33). 
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Fig. 33: Difference between the attachment of the external reference of the “Overlay” type (on the left) and the 
“Attachment” type (on the right) 

In case of the bridge above the “C” channel this means that the drawing of the road, which 

includes the drawing of the bridge as the external reference of the “Attachment” type, will be 

attached to the drawing of the bridge when attaching the drawing of the road to the situation 

drawing (Fig. 34). 
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Fig. 34: Display of the situation drawing with all external references, including the drawing of the bridge which was 
attached to the drawing of the road 
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Working with the blocks 
The blocks in the AutoCAD program are created by grouping multiple entities to facilitate 

the work with repeating objects in the used drawing. The block is defined by these objects and is 

inserted as required, multiple times in the drawing. The advantage is especially the possibility to 

change all the blocks inserted in the drawing by changing the block definition – this change is then 

reflected in each copy of this block in the drawing.  

Working with the blocks will be explained in two drawings: 

- in the first drawing, we create a block showing the floor plan of the sewer hatch, 

- in the second drawing, the solution of the sewer system in the new part of the 

municipality Veľký Lapáš is prepared where the sewer hatch block will be used. 

Creating the block 
The principle of creating, modifying, and using blocks will be explained in the creation of 

a sewer hatch block. It is given that the sewer hatch is of a circular shape with a diameter of 600 

mm and there are two circumferential holes in it for locking with a diameter of 20 mm (Fig. 35). 

Fig. 35: Layout of the sewer hatch with a diameter of 600 mm 

In the new drawing, therefore, we will create this basic design without dimensions, the 

drawing units will be millimetres – the design will be created as three separate circles with the 

required dimensions in the “thin” layer, which we will also create in the new drawing. From this 

created drawing (Fig. 36), we then create a block named “hatch”. 
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Fig. 36: Design of the hatch created from three circles 

You can start the creation of the block by using the command “BLOCK” or by using the 

icon on the “Block” panel on the “Home” tab, or on the “Block Definition” panel on the “Insert” tab 

(Fig. 37). 

Fig. 37: Using the command for block creation. 1 – icon from the “Home” tab; 2 – icon from the “Insert” tab 

When we use this command, a dialogue window (Fig. 38), is opened we you can set the 

parameters of the new block. When creating the block, enter the following parameters: 

1. “Name” – the name of the block that will be unique in the drawing,

2. “Base Point” – the insertion point – enter it using the selection on the screen or as the

coordinates of the drawing;

3. “Block Unit” – the units of the block – by default, the program automatically offers the

units of the drawing,

4. “Hyperlink” – the link that opens when you click on the block (Ctrl + clicking with the

left button of the mouse),
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5. “Objects” – the objects for the creation of a block – define the objects for the creation

and select what happens to the selected objects in the drawing. We can select one of the

three options:

a. to leave the objects as separate blocks and to create a block,

b. to convert the objects to a block, to remove them and to replace them with the

created block,

c. to convert the objects to a block and to remove them.

6. “Behaviour” – the behaviour of the block - we can select from the following options that

we can combine:

a. Annotative block

b. Unified scale of the block of all three axes

c. Enable block layout

7. “Description” – the description  of the block – it is used to describe the block, the

description is displayed in the Design Center (Fig. 47)

8. “Open in block editor” – the setting whether the block should be opened immediately in

the block editor

Fig. 38: Dialogue window to create a new block, 1 – name; 2 – insertion point; 3 – units; 4 – hyperlink; 5 – objects; 
6 – behaviour of the block; 7 – description; 8 – automatic opening in the block editor 

For the sewer hatch, set the following parameters (Fig. 39): 

1. name of the block – “hatch”

2. insertion block – centre of the hatch circle

3. units – millimetres

4. hyperlink – do not enter
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5. objects – three circles forming the design of the sewer hatch, converts the objects and

removes them

6. behaviour of the block – Unified scale of the block and Enable layout

7. description – “Circular hatch, diameter 600 mm”

8. to cancel the automatic opening in the block editor

Fig. 39: Creation of the hatch block from the selected objects, 1 – block preview 

The created block will be displayed in the drawing inserted into the original location, but the 

original objects (three circles) will no longer be in the drawing. By copying this block to different 

locations in the drawing, the individual blocks will be displayed in multiple locations. When 

selecting a particular block, the parameters of the particular selected block – name, location, units, 

and others are displayed in the property palette (Fig. 40). 
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Fig. 40: Multiple insertion of a block in the drawing, 1 – selected block; 2 – properties of the selected block 

Modification of the block 

If we need to change the definition of the block (modification, removal or adding of objects 

into the design of the block), and so that this change is reflected in each copy of the block in the 

given drawing, it is necessary to modify the block in the block editor that is started either by 

double-clicking the selected block or by clicking the right button and selecting the “Block editor” 

option in the local menu (but only one copy of this block can be marked, nothing else), or by using 

the icon on the “Block” panel on the “Home” tab or on the “Block Definition” panel on the “Insert” 

tab which opens the block editor, or the window for the selection of the block to be edited (Fig. 41). 

Fig. 41: Starting the block editor, 1 – selection from the local menu; 2 – icon from the “Home” tab; 3 – icon from 
the “Insert” tab; 4 – window for the selection of the block to be edited 
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When you open the block editor, a new “Block Editor” tab will appear, containing various 

tools fro block editing. In addition, a new “Close” panel appears on each tab to end the block 

editing. In the block editor, the necessary modifications are made – in case of the sewer hatch, the 

hatch diameter description and the handle display for handling the hatch are added. Subsequently, 

the block editor closes and changes in the block are saved (Fig. 42).  

Fig. 42: Saving the changes in the block editor, 1 – “Block editor” tab; 2 – “Close” panel to end the block editing; 
3 – saving the changes in the edited block 

Saving the changes of the block definition ensures that all copies of the block inserted into 

the drawing change without changing each block separately (Fig. 43). 

Fig. 43: Displaying the change of the block definition 
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However, each block copy can be changed individually as required in terms of placement, 

rotation, and insertion scale, independently of other block copies in the drawing (Fig. 44). 

Fig. 44: Changes of the particular block copies, 1 – block scale changed to 1.5; 2 – rotation angle of the block 
changed to 45° 

Using blocks in multiple drawings 
The created blocks can be copied between drawings, or added from the different drawings to 

the required drawing. If the units of blocks, or of the target drawings are set correctly, the program 

automatically re-calculates the drawing dimensions – as with external references. 

The simplest way is to copy the block into the clipboard, or copy the block into the 

clipboard through a reference point and then insert it into the target drawing. 

In case of a file with the sewer hatch block with the name “hatch”, first (rotation angle 0°; 

scale 1.0) copy this block into the clipboard through a reference point using the command 

“COPYBASE” or the shortcut Ctrl + Shift + C. Use the insertion point – centre of the hatch circle as 

the reference point. Then go into the situation drawing of the sewer system in the municipality 

Veľký Lapáš where we insert this block using the command “PASTECLIP” or the shortcut Ctrl + V 

to the first placement – the connection point of the sewer system branches (Fig. 45). 
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Fig. 45: Inserting the block “hatch” into the situation drawing of the sewer system, 1 - insertion point; 2 - scale of 
the inserted point 

The block inserted into the situation design had a scale of 1.0 in the block drawing, but after 

inserting it into the situation drawing, the scale of the inserted block scale was changed to 1,000. 

This change was performed because the software automatically converted the scale so that the 

object – a block with a diameter of 600 units (or 600 mm) had the same dimension also in the target 

drawing. But this means that in the situation drawing we also have the dimension 600 units and 

therefore 600 m – the scale must be 1,000 times the original scale. After changing the scale on the 

property panel to 1.0, the block diameter changes to 0.6 units, i.e. 0.6 m (or 600 mm) to ensure the 

correct size of the block display prepared in millimetres in the drawing prepared in meters (Fig. 46). 

This modified block can be copied in the situation drawing without the need to adjust the scale 

using the command “COPY”, as the copying in the drawing keeps the parameters of the copied 

block. 
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Fig. 46: Correctly modified scale of the block, 1 – scale of 1.0; 2 – insertion point of the block 

Another option for inserting a block from one drawing into another is to use the “Design 

Center” palette, which can be turned on using the command “ADCENTER” or by using the 

“Palettes” icon on the “View” tab (Fig. 47).  

Fig. 47: “Design center” palette, 1 – icon to turn on the “Design center” palette on the “Pallets” panel on the 
“View” tab; 2 – selection of the required file from which the objects will be moved; 3 – selection of the object type to be 

moved; 4 – window of displaying objects of the selected type in the drawing; 5 – preview of the selected object; 6 – description 
of the block; 7 – local menu for manipulation with the selected block, opened by clicking the right button of the mouse 

The required block can be added into the target drawing using the “Design center” palette in 

several ways: 

- by clicking and dragging a block from the display window of each object (the block is 

inserted in the place selected by the cursor by placing the insertion point); 
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- by selecting “Insert Block ...” from the local menu for the manipulation with the selected 

block, 

- by selecting “Copy” from the local menu for the manipulation of the selected block – the 

block will be copied into the clipboard by dragging the block using the reference point of 

the block. 

When inserting a block using “Design center”, the block will be inserted automatically with 

a scale set to 1.0. With correctly set units, the sewer hatch will have a diameter of 0.6 m. 

Subsequently, the given block of the sewer hatch is inserted into all areas where it is 

necessary to place the sewer shaft at all points of the connection of the individual branches, the 

slope or route direction change and in the distance up to 50 m between the particular shafts. 

If we insert a new block into the target drawing that has the same name as the block that is 

already defined in the target drawing, the program inserts the block that has already been defined 

and not the block that we want to insert. 

This situation will be explained in a practical example of the sewer system situation in 

Veľký Lapáš. The block of the circular hatch with the name “hatch” from the first file was inserted 

into the situation drawing – it is the hatch that will be placed in the road and it is a through road. In 

the next file, a hatch block, that is not a through hatch, was created, it has the shape of a square with 

the dimensions of 600 x 600 mm and is also named “hatch” (Fig. 48). 

Fig. 48: Two different blocks with the same name. Circular hatch (on the left); square hatch (on the right). 

When inserting a block of a square hatch into the situation drawing, this is the case that we insert 

a block named “hatch” which is created in the second drawing as a square hatch, but on the layer of the 

blocks of the situation drawing the block “hatch” is defined as a circular one – therefore, when inserting 

the block of a square hatch, the circular block is inserted. 

To eliminate this problem, it is therefore appropriate that the naming of the blocks with different 

definitions is always original: in case of the sewer hatches, there the block of the circular hatch should 
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be named, for example, “circular_hatch”, and the block of the square hatch should be named, for 

example, “square_hatch”– in this case it is possible to use both blocks in one drawing, as the names do 

not match. 

The naming of the blocks must be solved in al drawings, we can use the command “RENAME” 

which opens a dialogue window for renaming the named objects, such as blocks, layers, dimension 

styles, and others (Fig. 49). 

Fig. 49: Window for renaming the objects, 1 – list of types of the named objects; 2 – particular objects of the selected 
type in the current drawing; 3 – old name of the selected object; 4 – new name of the selected object 

 

After correct renaming, it is possible to insert the block of the square hatch into the situation 

drawing, and to use the block of the square as well as the circular hatch, and place them as needed. (Fig. 50). 

Fig. 50: Use of two hatch blocks in one drawing, 1 – name of the blocks is different; 2 – block “circular_hatch”; 
 3 – block “square_hatch” 
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Change of the block definition 
Changing the block definition, i.e. the design - the individual objects that make up a block, 

is possible either by modifying a block in the block editor or by redefining a block using “Design 

center” (only for blocks with the same name).  

The use of “Design center” for redefining a block is especially important when we have 

created a new definition for the block that we want to use for the re-definition of the existing block.  

In case of the sewer system in Veľký Lapáš, we have a block of a circular hatch named 

“circular_hatch” inserted into the drawing, and we have, from the selected supplier, a drawing with 

the precise solution of the hatch block – this block is named “hatch_circle_600_alloy”. The drawing 

of the block from the supplier is prepared in millimetres, much like this block, and for both blocks, 

the centre of the hatch profile is selected as the insertion point (Fig. 51). 

Fig. 51: Comparison of two blocks of the circular hatch. Original schematic block (on the left); new detailed block 
from the supplier (on the right). 

If we insert the detailed block from the hatch supplier into the situation drawing, the inserted 

copies of the schematic block are not re-defined, only the third block will be inserted (Fig. 52). 

Fig. 52: Insertion of the detailed block into the situation drawing 
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The change of all inserted blocks of the circular hatches by re-defining them for the design 

of the detailed circular hatch requires first the renaming of the block “hatch_circle_600_alloy” to 

the name “hatch_circular” in the source drawing of this block and then, using “Design center”, it is 

only possible to re-define all the blocks or to re-define all the blocks and insert another copy of this 

block (Fig. 53). 

Fig. 53: Using “Design centre” for the re-definition of the block (at the top); original blocks (at the bottom on the 
left); re-defined blocks (at the bottom on the right) 

Blocks with attributes 
The text used in the block definition remains the same for each inserted block, so any 

change of the text in the block definition occurs in all inserted blocks. In practice, however, there 

are cases when it is necessary for the block to contain a text element that can be modified as needed, 

separately for each inserted block. In these cases, a text object is not inserted into the block 

definition, but an attribute is defined for the object – a text object rewritable for each block that is 

inserted separately and independently of the other inserted blocks. The attribute can be defined for 

each block from separate objects before the block is created, or the attribute can be defined in the 

block editor in the already created block.  
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Defining the attribute will be demonstrated in the block of the circular hatch to which the 

attribute – the number of the shaft over which the block is located - will be added. In the block 

editor, the required block of the circular hatch is opened. The definition of the attribute is done by 

using the “Define Attribute” tool on the “insert” tab on the “Block Definition” panel, or by using the 

command “ATTDEF” in the command line. In the block editor, the attribute can also be defined 

using the “Block Editor” tab and the “Action Parameters” panel using the “Attribute Definition” 

tool. (Fig. 54). 

Fig. 54: Definition of the new attribute, 1 – defining using the “Insert” tab; 2 – defining using the “Block editor” tab 
available only in the block editor; 3 – mode; 4 – parameters; 5 – insertion point; 6 – text properties 

The definition of the attribute is done in the dialogue window (Fig. 54) in which the properties 

of the attribute are set: 

- Mode (Fig. 54 – 3): 

• Invisible – value of the attribute which is not displayed and printed,

• Constant – value of the attribute which is an invariable constant,

• Verify – during the insertion of the block, the user is prompted to verify the

accuracy of the value of the attribute,

• Preset – sets the value of the attribute to the pre-defined one without prompting

the entering of the value,

• Lock Position – locks the position of the attribute, the attribute cannot be moved,

• Multiple Lines – allow the creation of a multi-line text for the attribute.
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- Parameters (Fig. 54 – 4): 

• Tag – tag of the attribute, cannot contain a space,

• Prompt – prompt displayed during the insertion of the block. If the field of

prompt is not filled in, the tag (Tag) of the attribute will be used as the prompt.

The prompt is not displayed when you copy the block already inserted in the

drawing, but only when you insert the block (for example, using the command

“INSERT” or using the “Design center” palette).

• Default – predefined value of the attribute. This field does not need to be filled in.

• Insert Field – allows entering the predefined value as a field – interactive value

varies depending on the selected type (see chapter “Fields”).

- Insertion point (Fig. 54 – 5): allows to enter the placement of the attribute in the block, 

- Text properties (Fig. 54 – 6): allows entering the drag point of the text, its style, height 

and rotation angle of the attribute text. 

For the block of the circular hatch inserted in the situation drawing, we define a new 

attribute of the hatch number named “c_shafts” in the block editor so that its location can be moved 

as needed, when inserting the block, you will be prompted “Enter the shaft number” and the 

predefined value of the attribute will be “000”. The height of the text will be 200 – at a scale of 

1:100, the height of the text of this attribute will be 2 mm after the creation of the output, and the 

drag point will be “left” – left bottom corner of the text line (Fig. 55). 

Fig. 55: Defining the attribute of the shaft number for the circular hatch 

The attribute defined in this way will not be displayed in the already inserted blocks, and it 

cannot be edited because, during the insertion, the block did not have a defined attribute. The 

existing blocks must therefore be synchronized with the changed block definition. The 
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synchronization is done using the command “ATTSYNC” or by using the button “Synchronize” on 

the “Block Definition” palette on the “Insert” tab (Fig. 56).  

Fig. 56: Synchronization of the block attributes, 1 – Button of the synchronization tool 

for the attributes of the selected blocks 

After using the command, it is necessary to select which block will be synchronized - either 

by entering the block name in the command line or by selecting the block from the inserted blocks 

in the drawing. The synchronization then updates all the inserted blocks of that block name in the 

drawing. If the attribute has a pre-set value, this value is applied to all blocks (Fig. 57). 

Fig. 57: Synchronization of the attributes. The block and its properties before the synchronization (on the left) and 
after the synchronization (on the right). 1 – displaying the attribute on the properties palette; 2 – displaying the attribute 

itself as a text in the drawing. 

Thanks to the functionality of the attributes, for each inserted block it is possible to have the 

set attribute value independently of the other blocks. The modification of an attribute for the 

selected block is possible by rewriting it on the properties palette or acted double-clicking the 

selected block which opens the advanced attribute editor (Fig. 58). 
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Fig. 58: Window of the advanced attribute editor, 1 – attribute tag; 2 – prompt to enter the attribute; 3 – current 
value of the attribute; 4 – field for the change of the attribute value 

The block may have multiple unique attributes defined, each attribute may have a different 

mode. In the situation drawing of the networks, we create the markings block of the shaft type (Fig.

59) with three attributes:

- shaft type (direct, branch, junction of multiple sewers, ...) – visible attribute with locked 

position within a block, 

- angle of the pipes – visible attribute with locked position within a block, 

- supplier – not displayed and not printed attribute with locked position within a block. 

The block created in this way can then be used to describe the particular shafts – each can 

have a unique combination of attributes and the information on the potential supplier will not be 

displayed – for example, in case of a public procurement, it is not possible to clearly define the 

supplier or the producer of materials, but, as the information for the project designer, it is advisable 

to keep this information. 

Fig. 59: Block of the shaft description. Displaying the attributes in the block editor with all visible attributes (on the 
left); Displaying the attributes in the drawing – the attribute of the supplier is not displayed in the drawing but it is possible 
to display and modify it in the properties palette of the block. 1 – attribute of the shaft type; 2 – attribute of the pipes angle;  

3 – attribute of the supplier. 
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When selecting multiple blocks and modifying the attribute on the properties panel, the 

attributes of all selected blocks will change to the value specified on the properties panel (Fig. 60). 

This option is appropriate when multiple blocks require changing the value of the attribute to the 

same value – for example, for the marking blocks of items identifying the same type of shaft. In the 

example (Fig. 60) we see the change of the attributes of the marking for the shaft type (type 

“direct/180° to “branch/90°”). 

Fig. 60: Entering the same value of the attributes for multiple blocks using the properties palette. Blocks before the 
change of the attributes (at the top) and after the change of the attributes (at the bottom). 1 – values of the attribute for the 

selected blocks on the properties palette; 2 – selected blocks of the marking for the shaft type. Note: The attribute of the 
producer is not displayed in the drawing because it is in the “Invisible” mode. 

Using the layers 
The layers are used to better organize the drawing by allowing the individual objects to fit 

into the appropriate layer, thus changing the parameters of these objects using the changes made in 

the appropriate layers. 

Basic layer settings 

The “Layers” panel on the “Home” tab is used to work with the layers. (Fig. 61). To manage 

the existing, or to create new layers, we use the “Layer properties” button or the command 

“LAYER” which opens or hides the manager palette for the properties of the layers.   
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Fig. 61: “Layers” palette to work with the layers, 1 – “Layer properties” button 

The manager palette for the properties of the layers (Fig. 62) displays all the layers that are in 

the current drawing, including the external reference layers, and allow us to manage the individual 

layers. 

Fig. 62: Layer manager palette for the properties of the layers 

We can create a new layer in two ways: 

- by creating a new layer (Fig. 62 – 1), it creates a new layer which will have the same 

pre-set parameters as the current layer (colour, thickness and type of the line, etc.), 

- by creating a new layer (Fig. 62 – 2), it creates a new layer which will have the same 

pre-set parameters as the current layer (colour, thickness and type of the line, etc.) and 

that will be frozen in all viewports (see chapter “Layers and viewports”). 

The removal of the layer (Fig. 62 – 3) allows removing the layers, except for the following layers: 

- layer “0” and layer “Defpoints”; in the layer “Defpoints”, there are the points showing 

the dimensional lengths, the layer is created automatically after the creation of the first 

dimension in the drawing , then it cannot be removed, even after all the dimensions have 

been removed from the drawing, 

- current layer, 
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- layer in which there is at least one object; also applies to objects created in a block that is 

created in the drawing but is not inserted into the drawing, 

- layers of the external references. 

The setting of the current layer can be done by double-clicking on the name of the layer in 

the layers palette (Fig. 62 – 6) or by clicking the icon in the layers palette to set the selected layer as 

the current one (Fig. 62 – 4). 

The layers can be in three states: 

-  the current level is marked with a green tick in the column for the layer status (Fig. 62 – a),  

- the layer in which there is at least one object - grey pictogram (Fig. 62 - b), 

- the layer in which there are no objects – blue pictogram (Fig. 62 – c). 

The name of the created layers (Fig. 62 – 6) can be changed for all levels, except for the layer 

“0” and the layers of the external references. 

The layers can be turned on and off (Fig. 62 – 7) for the whole drawing. The turned-off layers 

will not be displayed in the drawing and will not be printed. The current layer may be turned off, so 

the objects are automatically not displayed until we turn on this layer. The existing object can be 

transferred to the turned-off layer from another layer. This function only controls the physical 

display of the objects, but the program still re-calculates the parameters of the turned-off objects, 

which can cause slower running of the program on large drawings. Also, when selecting objects 

through quick selection or selecting all objects (shortcut Ctrl + A), you can also select objects in the 

turned-off layers. 

The layers can be frozen or unfrozen (Fig. 62 – 8) for the whole drawing (model space and all 

viewports). The current layer cannot be frozen and the existing object can be transferred to the 

frozen layer from another layer. The frozen layers will not be displayed in the drawing, and the 

program will not re-calculate them when zooming, sliding the drawing, etc. When selecting objects 

through quick selection or selecting all objects (shortcut Ctrl + A), you cannot select objects in the 

frozen layers. The specific behaviour of frozen layers is also manifested in the blocks (see chapter 

“Working with layers and blocks”). 

The layers can be locked and unlocked (Fig. 62 - 9) for the whole drawing. The turned-off layers 

will be displayed in the drawing and printed but it is not possible to edit or remove the objects in these 

layers. This functionality is used especially for objects that are fixed and cannot be changed – for 

example, planimetry, topography, existing lines or objects, etc. which have to be taken into account 

when working on the project (for measuring distances, determining parameters of coordinates, lengths, 

number of objects, etc.), but it is important not to edit them (by mistake or on purpose). The current 

layer can be locked and the existing object can be transferred to the locked layer from another layer. The 

objects in the locked layer are displayed in a faded colour. The rate of the colour fading of the locked 
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layers is expressed in percentages from 0 to 90 (the default setting is 50), and it is determined by the variable 

“LAYLOCKFADECTL”, which can be started using the command line and entering a new value or setting 

the colour fading using the slider, or by entering the percentage value on the “Layers” panel on the “Home” 

tab (Fig. 63). 

Fig. 63: Fading of the object colour in the locked layer, 1 – slider and numerical value for the colour fading 

For the layers, is possible to set one colour (Fig. 62 – 10). We can use index colours (pre-

defined), use the system for the selection of true colours controlled by the RGB or HSL colour 

model, or use the selection from the colour libraries RAL, PANTONE, DIC Colour Guide (Fig. 64). 

Fig. 64: Selection of the colour layer, 1 – index colours; 2 – true colours; 3 – colour libraries 

For the layers, it is possible to select one of the various line types (Fig. 62 – 11). When selecting 

the lines, it is possible to select the lines defined in the file *.lin and the associated file *.shx (Fig. 65). 

The line structure is defined by this pair of files and the display mode, or the size of line components 
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(space, line, dot, etc.) is controlled by the variables of the total scale of the drawing, the total scale of the 

drawing lines, and the total scale of the lines of a particular object. 

Fig. 65: Selection of the line type. List of lines loaded in the drawing (on the left); Window for loading the lines from 
the respective file *.lin (on the right). 

Each layer can have one of the different line thicknesses (Fig. 62 – 12). The pre-set line thickness 

“Default” is set to the value of 0.25 mm and can be changed globally for the whole program using the 

variable LWDEFAULT, giving the number of hundredths of millimetres – the pre-set thickness 0.25 

mm is then set to 25. The display of the line thickness is controlled by the switch (Fig. 66) or by setting 

the variable LWDISPLAY.   

Fig. 66: Controlling the display of the line thickness in the drawing, 1 – switch for the display of the line thickness 

The transparency of the layers (Fig. 62 – 13) is defined as a percentage and can have the value of 0 – 

90. 

The printing style (Fig. 62 – 14) defines the colour in which the layer is printed. By default, 

this value matches the index colour. 

The setting of the layer printing (Fig. 62 – 15) determines whether the objects in the given layer 

are printed or not. This function is suitable for creating auxiliary constructions and notes that appear in 

the program but will not be printed. 

The setting of the freeze in the newly created viewport (Fig. 62 – 16) defines whether the layer 

in the newly created viewport is automatically frozen.  

The layer can be assigned a description (Fig. 62 – 17) that will simplify the user’s identification of 

the purpose for which the layer should be used.  
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Layer filters 
If necessary, it is possible to create layer filters based on their properties or by grouping the layers. 

This organized structure allows faster and more efficient work with the created layers. 

In case of the new part of the municipality of Veľký Lapáš, the engineering networks and 

connections are created in the respective layers. By creating a filter for the layer groups (Fig. 67) for public 

lines and connections, it is possible to quickly modify the turning on and off, freezing and unfreezing or 

locking and unlocking all the layers at once, as well as browsing the settings for only these layers – this 

function is used in the local menu which will be displayed for the given filter by clicking the right button on 

the required filter. When creating a groups filter, the layers are not moved from the list of all layers (filter of 

layer groups) or from the list of all the layers used (the filter of layer properties) as each layer can be 

included in multiple filters. 

Fig. 67: Using the layer filters. All layers (on the left); Created group of connections layers (in the middle); Local 
menu to set the turning off or freezing all layers in the group of connection layers (on the right). 

Other tools for working with layers 
The “Layers” panel offers additional tools for working with the existing layers (Fig. 68). 

Fig. 68: Other tools for working with the existing layers 
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Table 3: Other tools for working with layers 

T

ool 

Description 

1 turns off all the layers in the drawing 

2 turns on all the layers in the drawing 

3 

isolates the layer of the selected object - turns off or locks (the setting is done 

using the command line) all the layers in the drawing, except for the layer of the 

selected object 

4 
restores the state of the turning on or locking of all levels before using the 

isolation of the layer of the selected object 

5 freezes all the layers in the drawing 

6 unfreezes all the layers in the drawing 

7 locks all the layers in the drawing 

8 unlocks all the layers in the drawing 

9 sets the layer of the selected object as the current layer 

1

0 
moves the selected layer to the layer of the object of another selected object 

1

1 

returns the last change in the settings of the layers (colour, thickness, turning 

on/off, etc.) 

1

2 
moves the selected object into the current layer 

1

3 

creates a copy of the selected object and moves that copy to the selected object 

layer 

1

4 

allows to browse the list of layers - the selected layers will be displayed and 

the others will be hidden - it will be valid during the command, after the ending, the 

status can be returned to the initial setting 

1

5 

freezes the layer of the selected object in all viewports, except for the current 

one 

1

6 

joins the layers of selected objects to the target layer and clears the original 

layers 

1

7 

deletes the objects and the layer of the selected object 

1

8 

starts the manager of the layer status settings that allows to save or restore the 

status of the layers (colour, thickness, turning off, etc.) according to the required 

properties 
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Working with layers and blocks 
When working with the layers and blocks, it is necessary to take into account several 

specific parameters and to be aware of the basic principles that are connected with the solution of 

the blocks. First of all, it is necessary to be aware that a block made up of one or more entities is 

inserted in a given layer after insertion, independently of the layers of the individual entities that 

make up this block.  

In the situation drawing of the new part of the municipality Veľký Lapáš, after the re-

definition, there are several copies of the block “hatch_circular” with a detailed view of the sewer 

hatch, which is formed by a group of objects – lines, circles and arcs, all objects being in the “thin” 

layer.  

If some objects that make up this block are transferred to a different layer, the change will 

immediately appear in all copies of this block, and each of these blocks was transferred to 

a different layer (Fig. 69).  

Fig. 69: Changing the layers of the block objects, 1 – object (circle) in the “thick” layer of green colour; 2 – object 
(circle) in the “dotted” layer of blue colour; a – block in the “thick” layer; b – block in the “thin” layer; c – block in the 

“dotted” layer 

The layer in which the block is located does not affect the display of these blocks now. But 

if the “thick” layer is turned off, a circle that is in that layer disappears in each block, but the block 

that is completely in that layer will be displayed, except for the green circle in the turned-off “thick” 

layer (Fig. 70).  
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Fig. 70: Effect of the turned-off layer on the display of the blocks, 1 – turned-off “thick” layer; 2 – pictogram of the 
turned-off layer (bulb); a – block in the “thick” layer; b – block in the “thin” layer; c – block in the “dotted” layer 

But if we freeze the “dotted” layer, then a circle in the “dotted” layer disappears in each 

block, but also the block that is in completely in this layer will disappear (Fig. 71). 

Fig. 71 Effect of the frozen layer on the display of the blocks, 1 – frozen “dotted” layer; 2 – pictogram of the frozen 
layer (flake); a – block in the “thick” layer; b – block in the “thin” layer; c – block in the “dotted” layer is not displayed 

The “0” layer has specific properties that are reflected in the blocks so that the objects in the 

“0” layer, that make up the block, take the parameters of the colour, thickness, line type and 

transparency according tot he layer in which the whole block is placed. If we modify the hatch 

block so that part of the drawing objects displaying the anti-skid surface finish of the hatch moves 

to the “0” layer, these objects take the colour, line type and thickness according to the layer where 

the whole block is placed (Fig. 72). 
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Fig. 72: Behaviour of the “0” layer in the blocks. Objects in the “0” layer displayed in black colour in the definition 
of the block (on the left); a – block in the “thick” layer; b - block in the “thin” layer; c – block in the “dotted” layer 

The objects in the “0” layer respond to the turning off and freezing in the same way as the 

objects that are placed in the turned-off and unfrozen layer (Fig. 73). 

Fig. 73: Objects in the “0” layer and their behaviour during the turning off and freezing of the layer in which the 
whole block is placed. a – block in the “thick” layer – object in the “0” layer are turned off; b – block in the “thin” layer – 

objects in the “0” layer are displayed in the “thin” layer; c – block in the “dotted” layer is not displayed. 

Taking the properties of the colour, line type, thickness or transparency, as described at the 

“0” layer, can be achieved when the object in the block is in a layer other than “0” but the parameter 

of the colour, thickness and line type as well as transparency will be set to the value “ByBlock” 

(Fig. 74). 
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Fig. 74: Setting the object properties according to the selected parameters of the block, 1 – changed objects; 
2 – colour; 3 – line type; 4 – thickness; 5 – transparency 

If the object has one of the parameters set to “ByBlock” this setting will be reflected by the 

layer in which the block is created. Compared with the behaviour of the “0” layer, when the layer in 

which the block is placed is turned off, the parameters set to the value “ByBlock”  become evident 

(Fig. 75). 

Fig. 75: Parameter “ByBlock”. a – block in the “thick” layer; b – block in the “thin” layer; c – block in the 
“dotted” layer; 1 – turned-off “thick” layer; 2 – turned-off “dotted” layer. The objects of the outer ring in the hatch block 

are displayed as thick and green, or thin and blue in the objects a. and c. because they have taken only the parameters of the 
colour, thickness, line type and transparency. 
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Using the tables 

Basic properties of the tables 
It is suitable to use tables for a clear layout of text data. The table properties in the 

AutoCAD environment control the style of the tables, and the created table can then be changed 

according to the requirements in a different way than defined by the style of the tables. The window 

of the manager for the table styles can be opened on the “annotation” panel on the “Home” tab, or 

on the “Tables” panel on the “Annotate” tab (Fig. 76). 

Fig. 76: Working with the tables. Working on the “Annotation” panel on the “Home” tab (on the left); working on 
the “Tables” panel on the “Annotate” tab (on the right); 1 – starting the manager for the table styles; 2 – insertion of a new 

table into the drawing 

The window for the table styles (Fig. 77) consists of two parts. The left part contains the entire 

table data: 

- for the table style, it is possible to select one of the tables as the starting table, from those 

already in the drawing, 

- for each table style, it is possible to determine whether the table is made from top to 

bottom (table header at the top) or bottom up (table header at the bottom), 

- the preview shows the current setting for the given table style.  

The right part contains the tools for the management of the cell styles: 

- the cells have three basic styles – heading, column header and data cell, it is possible to 

create and manage also own cell styles, 

- the cell properties of a given cell style, 

- the preview shows the current setting for the given cell style. 
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Fig. 77: Manager of the table styles, 1 – selection of the start table; 2 – table direction; 3 – preview of the table; 
4 – cell style; 5 – cell properties; 6 – preview of the cell 

The cell properties of a given cell style allow setting up three types of properties: 

- general – background colour, alignment, format, type, text offset from the bottom and 

left margins of the cell, 

- text – style, height, colour, angle, 

- border – thickness, line type, colour, double border option. 

Creating a new table 

The use of the tables will be explained in an example of the sewer pipe report in the new 

part of the municipality Veľký Lapáš (Fig. 78), where we will create a table summarizing the 

diameters, the total lengths and the material of the individual pipes of the sewer system.  
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Fig. 78: Sewer pipes in the area in question 

Since there are ten branches of pipes in the site and each is described by four parameters, we 

create a table with ten data rows and four columns, where the first row will be the heading and the 

second row will be the column header (Fig. 79). 

Fig. 79: Inserting the table. 1 – selection of the table style; 2 – selection of the table type (empty table, table linked to 
the MC Excel spreadsheet), table for the extraction of object data in the drawing); 3 – preview of the table; 4 – insertion 

method (insertion point or window); 5 – setting the columns (number and width) and the rows (number and height); 
6 – determining the style of the first, second and all other rows 
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After inserting the table into the drawing, fill in the heading and header of the columns and 

enter the parameters for each pipe. The width of the columns can then be adjusted as necessary with 

the horizontal grab points of the cell in the required column (Fig. 80). We can also adjust the row 

height in the same way.  

Fig. 80: Inserting the table of the sewer pipe into the drawing, 1 – grab points for the adjustment of the column 
width 

If necessary, we can also adjust the cell dimensions on the properties palette: 

- column width – “Cell width” 

- row height – “Cell height” 

- text offset from the bottom edge of the cell – “Horizontal cell margin” (the parameter 

does not appear if the cell text is aligned to the centre of the cell in the horizontal 

direction), 

- text offset from the left edge of the cell – “Vertical cell margin” (the parameter does not 

appear if the cell text is aligned to the centre point of the cell in the vertical direction). 

We modify the columns of individual pipes so that both the heading and data cells of this 

column are aligned to the middle left of the cell, we adjust the columns of the average, length and 

material so that both the heading and data cells of this column are aligned to the central point of the 

cell and we adjust the data cell of the pipe length to the decimal point number rounded to two 

decimal places (Fig. 81). 
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Fig. 81: Adjusting the cells. Setting of the alignment for the cell content (on the left); Setting the content format 
(on the right); 1 – selected cells;  2 – cell alignment button; 3 – selection of the alignment to the middle central point; 4 – cell 

size format button; 5 – selection of the type of cell content; 6 – decimal format; 7 – preview of the formatted value; 8 – format 
type; 9 – rounding to the required number of decimal places.

Basic table adjustments and operations 
In addition to the basic adjustments of the existing tables, such as the editing of the dimensions, 

alignment, and formatting of the cell contents, other adjustments and operations are commonly used in 

table editors. In the case of the sewer pipe table, we will create another row in which we use the formula 

for calculating the total pipe length. 

The rows or columns can be added either by using the tools from the “Rows” (lines) panel or the 

“Columns” (columns) panel on the “Table cell” (tab, or by using the local menu which is displayed by 

clicking the right button of the mouse (Fig. 82). 

Fig. 82: Adding and removing rows and columns. Using the local menu displayed after clicking the right button of 
the mouse (at the top); Using the tools on the “Rows” and “Columns” panels on the “Table cell” tab (at the bottom). 
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After inserting a row at the end of the table, we calculate the total length of the pipe using 

the formula.  

The AutoCAD program allows using these basic formulas: 

- “Sum” – sum of the selected range values (empty and non-numeric values are ignored), 

- “Average” – average of the selected range values (empty and non-numeric values are 

ignored), 

- “Count” – the number of cells containing numeric values from the selected range (empty 

and non-numeric values are ignored), 

- “Cell” –  the value of the selected cell (the non-numeric value of the selected cell 

displays an error in the cell in question - ####), 

- “Equation” – a formula that uses basic mathematical operations with the option to enter 

a cell or cells from the existing table (the non-numeric values of the cells entered will 

display the error in the cell in question - ####). 

The calculation of the total length of the pipes is done by entering the formula 

“=Sum(C3:C12)” as the pipe lengths are entered into the cells C3 to C12. In addition to the direct 

entering of the formula text, we can specify this formula by using the “Formula” tool on the “Insert” 

panel on the “Table cell” tab or by using the local menu that appears when we use the right button 

of the mouse (Fig. 83). The formulas, or the values calculated by the formulas are standardly 

displayed with a grey background - the highlighted text indicates that it is a formula (or field) that is 

updated depending on the input values, or on the object parameters. After entering the formula, we 

modify the format of this cell to the format of the decimal number rounded to two decimal places. 

Fig. 83: Inserting the formula into the cell. Using the local menu displayed after clicking the right button of the 
mouse (on the left); Using the tool “Formula” on the “Insert” panel on the “Table cell” tab (on the right). 

The cells to the left of the total length of the pipe are merged to form one cell. We merge the 

cells after the marking of the required cells and using the “Merge” tool on the “Merge” panel on the 

“Table cell” tab or by using the local menu that appears when we use the right button of the mouse 

(Fig. 84). 
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Fig. 84: Merging multiple cells into one cell. Using the local menu displayed after clicking the right button of the 
mouse (at the top); Using the tool “Merge” on the “Merge” panel on the “Table cell” tab (at the bottom). 

 We add the text “Total pipe length:” into the merged cell and we align the cell content to the 

right central point of the cell. 

The table created in this way (Fig. 85)can then be used as part of the project documentation. 

Fig. 85: Resulting table of the sewer pipes 
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Fields 
Field (”Field”) is a text or numeric data that changes almost automatically depending on the 

parameter that was assigned to it. So we can, for example, insert text data about the date or time of 

the last save of the drawing, the current date, the name of the computer from which the last change 

of the drawing was made, as well as the parameters, or the properties of the selected object – circle 

radius, line length, block name, attribute value, and others – into the text (with paragraphs or with 

only one row). The advantage of using the field compared to the ordinary text data is the option of 

restoring, or updating the field value after changing the parameter – if the line length changes or if 

the date and time of the last saving of the drawing is changed, we do not have to manually change 

and overwrite the data, but the text change will take place depending on the program setting. By 

default, the field data is highlighted as the grey background of the text (similar to the formula in the 

table). 

The settings of the field properties (Fig. 86), such as the display of the background and the 

events from the update of all fields in the drawing, can be done using the “Field Update Settings..” 

tool in the window of the program properties “Options” on the “User Preferences” tab where the 

tool opens a menu in which we can select the time of the update for all fields – the following 

options are available:  

- opening of the drawing 

- saving the drawing 

- printing the drawing 

- eTransmit 

- regeneration of the drawing (command “REGEN” or “REGENALL”) 
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Fig. 86: Setting the field properties in the properties window “Options”, 1 – “User Preferences” tab; 2 – field 
setting; 3 – options of the update events for all fields in the drawing 

Inserting fields into the text objects 

 Adding a field into a single-line or paragraph text is done in the editing mode of the 

respective text object. To record the date of the last saving of the drawing, we create a text object 

with the text “Date of the drawing saving:”, where a field containing the date and time of the file 

creation will be placed behind the colon. After entering the text “Date of the drawing saving:”, 

right-click on the local menu and select the “Insert field” option that opens the dialogue window to 

insert the field (Fig. 87). 
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Fig. 87: Inserting the field for the date of the last saving of the drawing. Inserting the field into a single-line text 
from the local menu (at the top); Dialogue window with the properties of the inserted field (in the middle); Single-line text 

with the inserted field of the date and time (at the bottom); 1 – field category (Date & Time); 2 – field name (SaveDate – date 
of the saving); 3 – date format; 4 – key and help for the date fields. 

If it is necessary to change data the field has to display, the adjustment is done by double-

clicking on the field during text editing and then by selecting the required field. 

More than one field can be added to the text object, for example, in the text data above, it is 

possible to add a field showing the name of the user who made the last change using the same 

procedure – by activating the local menu and inserting the field. If necessary, also another text can 

be inserted between the fields (Fig. 88). 

Fig. 88: Multiple fields inserted in one object of a single-line text, 1 – date field of the last saving of the drawing; 
2 – name of the user who last saved the drawing 

In a similar way, it is possible to insert fields into the table cell. In the existing table of the 

sewer pipes, we modify, or remake the cells of the lengths of the individual sewers so that the 

length data take the length of the object of the line representing the respective sewer. If the length of 
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the sewer changes, it will not be necessary to manually overwrite its length in the table – the data 

will be updated, for example, after saving or regenerating the drawing. The advantage of this 

procedure is that the works on the project usually involve changes in the dimensions of the sewers, 

which, thanks to the use of the fields, are almost instantly projected into the table without the need 

for manual overwriting of the data. 

In case of paragraph texts, adding fields can be done only in the text editor by using the local 

menu activated by clicking the right button of the mouse or by using the “Insert” tool on the Text 

Editor” tab (Fig. 92).  

Inserting the fields into the attributes 
If blocks with attributes are used, fields can be added to the attribute by editing attributes in 

the window for the advanced attribute editor, where we insert the field using the local menu that is 

activated by the right button of the mouse.  

In this way, it is easy to describe the various elements. In case of the sewer system in the 

municipality Veľký Lapáš, a block with attributes was created for the description of individual 

sewers (Fig. 89). 

Fig. 89: Block for the description of the individual sewers, 1 – attribute of the sewer number; 2 – attribute of the 
pipe diameter; 3 – attribute of the pipe length; 4 – attribute of the pipe material; 5 – text of the note (pipe diameter); 6 – text 

of the note (pipe length) 

We insert a field into the attribute of the pipe length which will display the value of the line 

length representing the respective sewer. In the dialogue box for field insertion, we select the 

“Objects” category of the fields as we want to ensure that the attribute displays the parameter of the 

existing object – the length of the line creating the sewer. The “Object” option is selected in the 

field name, and then we select the object of the line for sewer no. 1 for the selection of the required 

object. In the list of object properties we select the “Length” option as this is the length parameter of 

the selected object. We select the “decimal” option as the field format to display in the decimal 

number format and we set the accuracy to two decimal places (Fig. 90).  
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Fig. 90: Inserting the field of the line length into the attribute, 1 – field category (Objects); 2 – field name (Object); 
3 – tool for the selection of the required object; 4 – displaying the type of the selected object; 5 – parameter of the selected 
object that will be displayed as a field (Length – length of the selected line); 6 – field format (Decimal); 7 – accuracy of the 

field value; 8 – preview of the field with the current setting 

The value of the line length inserted as a field is then displayed in the selected formatting 

and the attribute, or the field in the attribute will be highlighted in colour both in the window of the 

advanced attribute editor and in the design block itself in the drawing (Fig. 91). 

Fig. 91: Field inserted into the block with an attribute, 1 – highlighted text indicating the use of the field in the 
advanced attribute editor (on the left) and in the drawing (on the right) 
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Inserting the fields into the tables 
The field is inserted into a cell using the local menu by clicking the right button of the 

mouse during cell editing, using the “Field” tool on the “Insert” panel on the “Table cell” tab or 

during the editing of the selected cell using the “Field” tool on the “Insert” panel on the “Text 

editor” tab (Fig. 92). 

Fig. 92: Inserting the field into the table cell. Insertion into the cell (on the left); Insertion during the editing of the 
cell content using “Text editor” (on the right); 1 - tool “Field” to insert the field of the edited cell text or paragraph text. 

As with inserting a field into an attribute, it is also possible to insert the length of the line of 

sewer no. 1 into the table cell as a field, and, using appropriate format settings, we can ensure the 

required formatting of the value shown in the table. After the possible change in the length of this 

line and subsequent regeneration (or another event that is selected for field updates), this field will 

be updated, and therefore the value displayed in the table will be changed too (Fig. 93). 

Fig. 93: Updating the field inserted into the table cell. Status before the change of the line length and field updates 
(on the left) and after the change of the line length and field updates (on the right); 1 – length of the selected line; 2 – cell with 

a field displaying the length of the selected line; 3 – selected line. 
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Field linking 
We can refer to other fields using the fields. In the sample example describing the insertion of a 

field into a table, we referred to the value of the line length. But we can use the field inserted to the table 

to refer to the field of the block attribute describing the respective sewer which is used to refer to the 

value of the line length. If the cell fields contain numeric data, it is possible to perform mathematical 

operations with cells using formulas – addition, subtraction, multiplication, division, and others (Fig. 94).  

Fig. 94: Field linking. 1 – length of sewer no. 6 in the block attribute as the field referring to the line length;  
2 – length of sewer no. 7 in the block attribute as the field referring to the line length; 3 – length of sewer no. 6 in the table as 

the field referring to the block attribute; 4 – length of sewer no. 7 in the table as the field referring to the block attribute; 
5 – total length of sewers no. 1, 2, 6 and 7 calculated as the sum of the cells with a correct result 

 

However, the calculation with the sum formula will not work in this case because the sum 

formula only works with numeric data, but when using a field referring to an attribute, this field has a 

text format and therefore these values will not be included in the calculation (Fig. 95). 

Fig. 95: Field linking. 1 – length of sewer no. 6 in the block attribute as the field referring to the line length;  
2 – length of sewer no. 7 in the block attribute as the field referring to the line length; 3 – length of sewer no. 6 in the table as 

the field referring to the block attribute; 4 – length of sewer no. 7 in the table as the field referring to the block attribute; 
5 – total length of sewers no. 1, 2, 6 and 7 calculated as the sum of the range cells with an incorrect result 
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Possibilities of linking CAD and MS Excel 
Depending on the requirements on project documentation, we often encounter the need to 

use and link data from the CAD environment with data represented by a table entry - whether we 

are talking about comma separated values (files *.csv) or text files or files for the work in the MS 

Excel program (*.xls or *.xlsx). This can be the export of data from CAD to a spreadsheet file or 

vice versa, the import of spreadsheet data into CAD. In the environment of the CAD program, both 

of these tasks can be solved with using the appropriate tools integrated directly into the program. 

Creating a link to the table 
The existing program table in the *.xls file can be inserted into the drawing as an OLE-type 

object ( Object Linking and Embedding) by copying and pasting it with the usual shortcut Ctrl + C 

and Ctrl + V to ensure that the table is inserted into the drawing while maintaining the formatting 

according to the source – the table will have the parameters (formatting, content, dimensions, 

border, font, ...) as in the *.xls file from which the data are taken. 

But the import of the table allows for the formatting and table contents of the drawing as 

well as the use of data for further calculations as well as the change of the data in the source file 

directly using the drawing. 

The data import will be explained using the connections in Veľký Lapáš, where a table 

containing the production program of concrete sewer shafts will be attached to the drawing. 

Before importing, first it is necessary to create the link of the drawing to the *.xls file using 

the data link manager (data link) that will be started by the “Data Link” tool on the “Linking & 

Extraction” panel on the “Insert” tab. In the “Data Link Manager” option, we create the new link and 

name it appropriately (Fig. 96). 
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Fig. 96: Creating a new data link to the table, 1 – “Data Link” tool; 2 – creating a new link of the *.xls file and the 
current drawing; 3 – name of the new link 

When creating a data link, it is necessary to define the parameters of this link (Fig. 97). The 

basic parameters include: 

- location and type of path (relative, whole, no path) to the linked file, 

- parameters of the linked file – sheet selection, link options (entire sheet, named range, 

defined range), 

- cell content (retain the data format and formulas, retain the data format and use formulas 

in MS Excel, convert the data format to text and use formulas in MS Excel); 

- enable writing into the source file – allows the *.xls file to be updated according to the 

changes made in the drawing table, 

- cell formatting – use of MS Excel formatting and update it according to the formatting in 

the *.xls file, or start with the MS Excel formatting and do not update it later. 
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Fig. 97: Parameters of linking the file of the MS Excel program, 1 – file selection; 2 – parameters of the linked file;  
3 – cell content; 4 – writing into the source file; 5 – cell formatting; 6 – preview of the currently linked content of the selected 

file 

Inserting the table in the drawing 

The created data link can then be used to insert a new table into the drawing, possibly 

reopening the data link manager for additional editing or creating a new data link (Fig. 98). 
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Fig. 98: Inserting a new table using the created data link to the file of the MS Excel program, 1 – data link selection; 
2 – starting the data link manager 

In the model example, the whole “Sheet1” from the “range.xlsx” table will be inserted, as the 

option to link the whole sheet was selected in the data link manager. After marking, the inserted 

table indicates the highlighted table corners in green colour that indicate the part of the table 

inserted as a data link to a file of the MS Excel program. The cursor will change when pointing to 

any of the linked cells – it displays the lock symbol (locked cell) and the chains (link to the contents 

of the MS Excel file) as the link of the MS Excel table creates a locked and linked table in the 

drawing (Fig. 99). 
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Fig. 99: Table of the range of concrete elements for the sewer shafts inserted into the drawing using the data link to the table 
of the MS Excel file. 1 – highlighted green corners of the table that indicate the part of the table linked using the data link;  

2 – cursor indicating the cell that is locked and linked to the table file. 

Editing the existing data link 

In case we created a data link whose parameters are then have to be edited for objective 

reasons according to our requirements, it is possible to perform this modification also additionally 

or after inserting the table that refers to this data link.  

In the example of inserting the table with the range of concrete elements from the 

“range.xlsx” file, several rows are inserted in the linked sheet too, which are not interesting for the 

drawing , as only the cells with the description of the columns and the data are required. For this 

purpose, it is not necessary to modify the source file of the table, but simply change the settings of 

the data link manager so that the given data link is not linked to the whole “Sheet1” but only to the 

range of cells we need to insert into the drawing, thanks to which the table already inserted into the 

drawing will be displayed in this modified setting (Fig. 100). 

Fig. 100: Changing the created data link. Editing the range of the data link (on the left); Inserted table after the 
change of the data link (on the right); 1 – setting the range of the data link. 
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Updating the imported data 
In addition to the simplicity and speed of importing the table data from the MS Excel file, 

the advantage of linking the AutoCAD and MS Excel programs is also the possibility to update the 

data. In case of using the data links, the changes can be done in both directions – to transfer the 

change in MS Excel into the drawing or vice versa, to write the change in the table in the drawing 

into the source MS Excel file. This function is used especially in cases when there are changes to 

the project, which must be registered in the MS Excel table, but also in the table inserted in the 

drawing. 

In the table of the range of concrete products, it is necessary to make a change – the weight 

of the individual components has been changed due to the modification of the concrete mixture 

formula by the manufacturer and the file with the new parameters has replaced the original file. The 

changes can be re-loaded using the “Download from source” tool on the “Linking & Extraction” 

panel on the “Insert” tab so that the whole data link is re-loaded and updated according to the 

change in the MS Excel file (Fig. 101). 

Fig. 101: Updating the data of the data link. Tool for data loading from the source file 1; original weight values 
(table on the left); new weight values (on the right). 

The update of the data in the AutoCAD environment and the subsequent sending of the data 

to the source file requires a slightly different approach, as the data imported using the data link, or 

the imported table is inserted into the drawing so that the cell contents are locked, so first it is 

necessary to unlock the cells using the “Cell Locking” tool on the “Cell Format” panel on the “Table 

cell” tab. In this way, in the example we can unlock the cells with product descriptions and edit the 

product names “D07509” and “D07512” to “Shaft bottom – extended” (Fig. 102). 
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Fig. 102: Unlocking the locked cell linked through the data link, 1 – “Cell Locking” tool; 2 – setting the unlocking of 
the selected cell 

Then the changes made in the AutoCAD environment can be sent into the source file and to 

update it using the “Upload to Source” tool on the “Linking & Extraction” tool on the “Insert” tab 

(Fig. 103). Before sending the data, this file must not be opened, otherwise the update of the source 

file will not be performed. 

Fig. 103: Sending the changes into the source file, 1 – “Upload to Source” tool 

Editing the linked table and using the formulas 

The table object in the AutoCAD program can be extended by adding columns or rows. In 

case of tables linked to the MS Excel files, these tables can only be expanded outside of the linked 

parts of the table, so rows can only be added above and below the linked table, and the columns can 

only be added to the left and right of the linked table. If it is necessary to extend also the part of the 

linked table, you need to perform this extension in the MS Excel program. In case the data link is 

created with a link only to a specific part of the sheet, it is necessary to modify this range in the data 

link manager of the AutoCAD program, as adding a row or column moves the existing rows down 

and the existing columns to the right. 

Various table operations can be performed, as needed, using the cells of the linked table. In 

case of the sewer system in Veľký Lapáš, we will expand the inserted table of the production range 

by adding two columns: a column with the number of pieces and a column with the total weight of 

the individual components, and adding a row with a summary of the total weight of all elements 

(Fig. 104). 
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Fig. 104: Extending and using the formulas in the table linked to the MS Excel file. 1 – added column of the number 
of pieces; 2 – added column of the total weight of the individual components; 3 – added row of the total weight of all 

products; 4 – use of the formulas to calculate the weights of individual components (multiplication of the cell with the number 
of pieces and the cell with the weigh of one piece); 5 – using a formula to calculate the total weight of all components (sum of 

values from cells H2 to H14) 
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Possibilities of linking CAD and GIS 
Designing tasks in the area of landscape planning are largely related to the use, or the need 

for knowledge of the geographic location – whether it is the route of a proposed water pipeline, the 

demarcation of land borders, the creation of terrain profiles, or the incorporation of the planimetry 

and topographic data into the project. The expansion of the use of Geographic Information Systems 

(GIS) is therefore creating more and more options for combining these two systems with the use of 

advantages, data and tools from both areas. But it is necessary to know that the use of both systems 

is based on different principles and data structures whose knowledge leads to more efficient and 

precise processing of designing tasks. 

At present, similar to the CAD applications, various GIS programs can be used to work with 

raster, vector, or general database information. Some programs are charged, others may be licensed 

under the conditions of the licences of the GNU Free Software. The adjective “free” means that 

users can copy, modify, and distribute it without any limitations. 

In order to understand the basic options for linking and using CAD and GIS, we will work 

with the QGIS GNU software. 

Importing the CAD data into the GIS environment 
In the GIS environment, we can generally talk about three basic elements of geometry: 

- points 

- lines 

- areas 

For the documentation in the CAD file format (*.dwg or *.dxf), documentation is also made 

up of various other types of objects (dimensions, texts, blocks, tables, hatches, etc.), which may 

cause generalization or replacement by other types of objects during the import into the GIS 

environment. 

The import of the CAD data into the GIS environment will be explained using the situation 

drawing of the Radošinka stream. The data in the CAD file format can be loaded into the QGIS 

environment in the *.dxf file format, so we need to save this drawing in this format. 

As we work with the drawing documentation in the S-JTSK coordinate system in the 

Krovak view, it is necessary to create a QGIS project in this coordinate system. Our coordinate 

system is S-JTSK (Greenwich)/Krovak East North, EPSG: 102067. We link the basic map of the 

Slovak Republic as a WM layer to the project (link: 

http://nipi.sazp.sk/arcgis/services/podklady/zbgis10r/MapServer/WMSServer/?), with which we 

will continue to work together with the documentation of the Radošinka watercourse (Fig. 105). The 
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coordinate system is S-JTSK (Greenwich)/Krovak East North, EPSG: 5514, at the time of processing 

this study material, had problems with the use of the Basic Map of the SR when it was connected to the 

WMS server, so the EPSG 102067 coordinate system has been selected for the project.  

Fig. 105: Project in the QGIS environment - Basic Map of the SR linked via the WMS server. 1 – tool for adding 
vector data 

It is then possible to load the *.dxf file with the situation of the Radošinka stream using the 

“Add Vector Layer” tool in the same way as when loading the *.shp files used in the GIS programs. 

Since *.dxf as a file does not have a defined coordinate system but the drawing contained in it is 

prepared in the S-JTSK coordinate system, it is necessary to select a suitable coordinate system (Fig. 106) 

– in this case, it is also possible to select the EPSG 5514 coordinate system, since the coordinate system

of the added file is defined and not of the whole project. 

Fig. 106: Selection of the coordinate system of the added *.dxf file in the QGIS environment 
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Since the *.dxf file contains, or may contain various types of geometry, it is necessary to select a 

type of geometry to be added from the required *.dxf file to the QGIS project, while it is possible to 

select several types geometry by holding down the Ctrl key and by selecting using the mouse in the list 

of possible types of geometry (Fig. 107) – in case of the Radošinka stream, we need to add line objects, so 

we select the “LineString” option to add the line objects. 

Fig. 107: Selection of the type of geometry for the objects to be added to the project 

Then, we will re-select the coordinate system for the added objects (either EPSG 5514 or 

EPSG 102067), and all the line objects (as well as arcs, circles, ellipses, and others) will be added to 

the project. Adding the objects ignores the tuning on/off or freezing/unfreezing the layers of the 

*.dxf file, and it adds all the objects of the selected type to the project (Fig. 108).   

Fig. 108: Line objects inserted into QGIS – their displaying on the WMS background of the Basic Map of the SR 

The *.dxf file imported in this way can then be stored in the QGIS environment in various 

formats, such as *.shp, and its content can be used and processed for intended purposes (analyses, 

map outputs, etc.). 
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Exporting the GIS data into the CAD environment 
The data from the GIS environment can be exported as needed to the CAD environment, 

where it is possible to integrate them according to the project documentation. In this way, for 

example, it is possible to take the boundaries of the territory from historical maps, the way of land 

use, the landscape structure from the orthophotomap, to take the vector polygon layer of the 

cadastral map and others.  

In case of the Radošinka stream, we take the course of the melioration channels from the 

Basic Map into the drawing of the Radošinka stream. We will work with the project in which we 

have imported the *.dxf file of the Radošinka stream crossing the road which connects the villages 

Zbehy and Čakajovce. 

In the existing project, we will create a new *.shp file in which the line objects of both 

meliorating channels will be created, the coordinate system of the layer will be EPSG 5514 and in 

this layer we will create two line objects – each of them will represent one channel (Fig. 109). 

Fig. 109: Creating the newlines – channels, 1 - channel no. 1; 2 – channel no. 2; 3 – newly created layer of the 
channels 

The objects created in this way can then be saved in the *.dxf format. By right-clicking the 

desired layer we will activate the local menu, where we select the “Save as” option to open the 

dialogue box for storing the respective layer. In this window we select the file format (AutoCAD 

DXF), the storage location and the coordinate system (EPSG 5514 or EPSG 102067), and we save 

the file (Fig. 110). The file is then added to the current QGIS project. 
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Fig. 110: Saving the requested *.dxf file, 1 – “Save as ...” menu; 2 – setting the *.dxf format for the new file; 
3 – setting the coordinate file of the new file; 4 – setting the location of the new file 

The newly created file can then be opened in the AutoCAD program. As we exported only 

the layer of new channels, this newly created *.dxf file will not contain anything else other than the 

two objects of the “Polyline” type (Fig. 111). 

Fig. 111: Newly created *.dxf file containing two channel objects 

Since the original files of the Radošinka stream (*.dwg and *.dxf) as well as the file of the 

new channels are prepared in the S-JTSK coordinate system, the new channels can be transferred to 

each of the original files by copying with the basic point (see chapter “S-JTSK coordinate system in 

the AutoCAD environment”), or by using external references after saving the new file in the *.dwg 

format and setting the correct units (metres) for both drawings (Fig. 112). 
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Fig. 112: Displaying the channels linked as an external reference to the situation file of the Radošinka stream, 
1 – channel no. 1; 2 – channel no. 2; 3 – external reference of the *.dwg file of the channels 

This trivial task explains the possibility of exporting data from the QGIS environment, but it 

should be noted that in this way it is possible to transfer any vector data that can also be generated 

as a result of more complex and complicated tasks such as determining the boundary of a river 

basin, finding a territory with a slope greater than that required value for the demarcation of the 

protective grassing or forestation, the import of contour vectors, and other tasks requiring the 

processing of the project documentation based on various GIS analyses, and their subsequent import 

into the CAD environment will allow these data to be used as a basis for the processing of the 

project documentation and preparation for the subsequent geodetic demarcation in the terrain. 
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Advanced printing options 
For the usual needs of the project documentation in the field of landscape planning, in 

general, we can talk about two basic types of graphical outputs: 

- drawings printed on paper, 

- digital drawings in the form of raster images or vector graphics. 

In both cases, we can use the command “PLOT” which allows for the detailed and accurate 

setting of the parameters for the printing of the drawings or outputs in the *.pdf format. Another 

option to create *.pdf files is the export, but it does not provide as many options and settings as 

PLOT, so we will not work with it in this publication. 

Drawing sheet – Layout 
The separate drawing sheet – Layout (Fig. 113) represents a single sheet of paper with 

multiple settings (drawing size and orientation, print styles, printed objects, etc.). One file can have 

a maximum of 255 layouts, the setting each one can be independent of the others. This makes it 

possible to create layouts in different dimensions, orientations printed on different printers and the 

like. It should be noted that the layout (also known as the paper space) and the model space are two 

different spaces; while it is possible to enter and to display the model space from the layout using 

the viewport. The viewport is a window that is used to look at the objects placed in the model space 

from the layout space. In general, the model space is an infinitely large three-dimensional space in 

which a starting point is defined (a point with zero coordinates in the direction of the axes x, y, z) 

and in which individual objects can usually be found in their real dimensions in the selected units. 

Fig. 113: Layout – separate drawing sheet, 1 – layout tab; 2 – area outside the drawing; 3 – drawing area out of 
printing range; 4 – limit of the printing range; 5 – viewport boundary; 6 – button for layout editing on the “Layout” tab 
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Each layout has a tab (Fig. 113 – 1) that serves to open the required layout. The grey area (Fig.

113 – 2) is a part outside the drawing itself (Fig. 113 – 3) – the dimensions and orientation of the 

drawing are given by the layout settings. The drawing has a default printable area (Fig. 113 – 4), 

with the beginning of the layout coordinate system (point 0.0) which is the lower left corner of the 

printable area. The objects outside this area will not be printed. In the layout, viewports can be 

inserted – they are cut-outs that show part of the model space in the required location in the required 

zoom (Fig. 113 – 5). The outline of the viewport cannot be turned off and will be printed in a setting 

where the layer in which it is created has been set. If the outline of the viewport is not required to be 

displayed, it must be placed in a layer that has the offset print parameter turned off (Fig. 62 – 15). 

The layout parameters determine its setting which can be modified as required. The editing 

of the layout settings can be done either by clicking the required tab and choosing the “Page setup 

manager” option or by using the icon on the “Layout” tab (Fig. 113 – 6). 

The layout setting (Fig. 114) is the same as the standard window with print settings. 

When creating outputs, the software offers the use of the installed printers (Fig. 114 – 1) as 

well as a series of custom printers that can be used. We can mention mainly “DWG to PDF” and 

“AutoCAD PDF” for the creation of the *.pdf files and “Publish to Web” for the creation of outputs 

in the *.jpg or *.png raster format.  

The size, or the format of the paper in the printers (Fig. 114 – 2) may vary depending on the 

selected printer. To create a custom paper format, this function can be found in the printer 

properties. 

The print area (Fig. 114 – 3) of the layout can be set as for normal printing - to the displayed 

part, window, limits, and range, but it also allows the “Layout” setting which can be used to print 

the drawing or the layout as it is currently set, i.e. it prints the range of the printable area given for 

the used paper format. The offset of the printed region (Fig. 114 – 4) determines the offset of the 

beginning of the layout coordinate system from the lower left corner of the printable area. 

The assignment of the print styles (Fig. 114 – 5) determines the use of the tables of the 

object properties assignment (colour, thickness, line type, etc.) for the given layout. Each layout in 

the drawing can have a different table of print styles selected. 

The setting of the print quality and print styles (Fig. 114 – 6) determines the quality at which 

the layout is printed. In contrast to the print settings, from the model space it is not possible to set 

the display style for the layout – this must be set separately for each viewport. 

The print settings (Fig. 114 – 7) allow to turn on or off the options of the printing for the line 

thickness, transparency, printing with the print styles, to print the whole area of the paper, or to hide 

the objects in the area of the paper. 
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The orientation of the drawing (Fig. 114 – 8) allows to adjust the orientation of the paper 

horizontally or vertically. This option allows rotating the paper if the selected printer has no pre-

defined paper format, especially for the horizontal and vertical orientation, or when it is necessary 

to keep the edges defined by the paper format, but the orientation should be different from that 

specified by the format.  

The preview of the layout with the current settings (Fig. 114 – 9) allows to browse the 

drawing with the currently set parameters before printing. The total scale of the layout printing (Fig. 

114 – 10) when printing from the layout is set to 1:1 by default, so all the objects – viewports as 

well as the other objects inserted directly into the paper space of the layout will be displayed as set 

for the given layout. 

Fig. 114: Layout parameters. 1 – printer selection; 2 – paper format; 3 – printing area; 4 – offset of the printed area; 
5 – table of the print styles; 6 – setting of the display styles and print quality; 7 – options of layout print settings; 8 – drawing 

orientation; 9 – preview of the layout with the current settings; 10 – total scale of the layout printing. 

Using the viewports 
The options of layout creation or the function of the viewports will be demonstrated in an 

example of the situation of the pumping station at the Radošinka stream, where the room of the 

warehouse control centre has been added. (Fig. 115). The goal will be to create an A3 drawing, 

where, in the scale of 1: 200, the whole object of the pumping station will be displays, as well as the 

detailed floor plan of the control centre in the scale of 1:50. The equipment and description with the 

dimensions of the control centre created in its own layers, which will allow controlling the display 
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of these elements depending on the floor plan in question (the overall floor plan of the station or the 

detailed floor plan of the control centre). 

Fig. 115: Overall floor plan of the pumping station (at the top) and detailed floor plan of the control centre (at the 

bottom) 

The first step is to set the page. We use the “page setup manager” tool for “layout1” to set 

the following parameters:  

- Printer “DWG to PDF” 

- Paper format ISO A3 (420.00 x 297.00 MM), 

- print area: Layout, 

- offset of the printed area: 0.00 for both axes, 

- assignment of the print styles: “monochrome.ctb” (only for black printing), 

- drawing orientation: Landscape (width), 

- total scale of the layout printing: 1:1. 

These settings will immediately appear on the selected layout (Fig. 116). 
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Fig. 116: Layout of the floor plan drawing for the pumping station, 1 – area outside the selected drawing format A3; 
2 – drawing of A3 format (area outside the printable area defined by formatting for the selected printer); 3 – border of the 

printable area; 4 – viewport frame; 5 – part of the model space displayed in the given viewport 

The viewport can be edited to the desired shape, or size by its marking and the displacement 

of its top points. From the layout space, it is possible to enter the model space in two ways: 

- by double-clicking the inner part of the viewport, 

- by marking the required viewport and by clicking the switch “PAPER” or “MODEL” in 
the status line (Fig. 117 – 4). 

Upon entering the model space, the viewport frame changes its thickness, and the cross line 

of the cursor does not extend beyond the viewport frame. Then it is no longer possible to 

manipulate the objects in the layout, only the objects in the model space. Also, the control of the 

displaying – zooming in/out and scrolling is applied to the model space until the display of the 

particular viewport is locked. The coo-rdinates displayed in the status line show the current position 

of the cursor in the model space (Fig. 117). 
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Fig. 117: Entry into the model space through the viewport, 1 – changed thickness of the viewport frame indicating 
entry into the model space; 2 – model space in which the display has changed – zooming in on the part of the control centre; 

3 – cross line (not exceeding the viewport frame); 4 – switch for switching between the model space and the paper; 
5 – coordinates showing the cursor position in the model space 

The leaving of the model space in the viewport is similar to the entry into this space: 

- by double-clicking outside the area of the viewport, 

- by clicking the switch “PAPER” or “MODEL” in the status line (Fig. 117 – 4). 
The setting of the view scale of the viewport (Fig. 118) on the drawing prepared in the same 

units as the units of the paper format can be performed in two ways: 

- by using the command “ZOOM” via the command line inside the viewport and entering 

the desired scale in the format “1/MMMxp”, where MMM is the scaling number – for 

the scale 1:50 the entered value is “1/50xp”, 

- by marking the viewport frame and setting it on the property palette - either by selecting 

the scale in the pre-defined scale list or by entering the custom scale in the “Custom 

scale” field in the format 1/MMM format where MMM is the scaling number - for the 

scale 1:50 it is the value of 1/50 or its decimal format of 0.02 calculated as 1:50.  

In both cases, the “Custom scale” value will always be displayed as a decimal format. In 

general, the use of the fraction in the “Custom scale” is more suitable as there is no rounding, for 

example when selecting the scale of 1:75. 
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Fig. 118: Setting the viewport scale. On the left – setting from the inside of the viewport; 2 – setting from the paper 
area through the properties palette. 1 – entering the scale using the command “ZOOM”; 2 – setting the scale in the 

“Standard scale” or “Custom scale” fields. 

After setting the correct scale, it is advisable to lock the viewport display to prevent the 

unwanted scale changes, for example, by zooming in or moving the display inside the viewport 

using the middle button of the mouse. In the locked viewport, the zooming in/out or moving the 

display applies to the entire layout, not only to model space displayed in the current viewport. The 

locking as well as unlocking of the viewport can be performed in two ways (Fig. 119): 

- using the button in the status line, 

- setting in the properties palette. 

Fig. 119: Locking the viewport, 1 – using the button in the status line; 2 – using the properties palette 
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There may be a maximum of 64 active viewports in one layout. The new viewport can be 

created either as a copy of the existing viewport or by inserting a new viewport using the “Layout” 

tab and by selecting on the “Layout Viewports” panel (Fig. 120).  

Fig. 120: Inserting a new viewport, 1 – square; 2 – polyline; 3 – using the existing object in the layout 

In addition to the viewports, it is possible to insert the design of other objects into the layout 

itself and to move or change it arbitrarily. In case of the pumping station at Radošinka stream, the 

headings of the individual floor plans, the corner listing, the tables of the equipment and the notes to 

the drawings were added to the two viewports. 

Layers and viewports 
For the individual viewports, the modification of the layer properties is necessary for the 

correct displaying or turning off the displaying of the required objects. In case of an overall floor 

plan, it is necessary to turn off the description of the control centre as well as the equipment, while 

in the floor plan of the detail of the control centre, these objects have to be displayed, therefore we 

cannot use the total freezing or turning off the layer. For this purpose, it is advisable to use the 

freeze option in the current viewport that is displayed after entering the viewport in the scrolling list 

of layers as well as on the palette of the layer properties (Fig. 121). 
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Fig. 121: Freezing or unfreezing the layer in the active viewport, 1 – setting by using the layers list on the “View” 
tab on the “Layers” panel; 2 – setting by using the palette of the layer properties 

By freezing the layer of the description of the control centre, the layer of the items in the 

viewport of the pumping station floor plan as well as the freezing of the layer of the overall 

description in the viewport of the detailed floor plan of the control centre, we achieve the required 

content of the particular viewports. Since the freezing of the layer of the description of the control 

centre was performed only for the particular viewport, the names of the floor plans created in that 

layer, but inserted directly into the layout, will be the headings displayed in the layout (Fig. 122). 
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Fig. 122: Freezing the layer in the selected viewport, 1 – floor plan without the display of the description of the 
control centre and the equipment; 2 – detail of the control centre with the displayed description and the equipment and the 

turned-off overall description (missing heading “VELÍN” visible in the overall floor plan inside the object of the control 
centre); 3 – headings of the floor plans displayed despite the fact that this layer is frozen in one of the viewports 

If the viewport frame is not to be displayed after printing, the viewport must be moved to 

a layer that is not printed. 

The resulting drawings of the pumping station floor plan with a detailed floored plan of the 

control centre can then be printed to create a PDF file (Fig. 123), displaying the individual objects 

according to their setting, and the colour of all the objects that are printable will be black because 

the layout was assigned the “monochrome.ctb” print style. 
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Fig. 123: Resulting drawing of the pumping station 

Scale of the drawing viewport with various units and the coordinate systems of 

the viewports 
In case of drawings prepared in meters and using the paper format in millimetres, the setting 

of the viewport scale is slightly different. This case will be demonstrated in the drawing of the 

schematic situation of the Radošinka stream at the site of the road bridge to the village of 

Čakajovce, which is prepared in S-JTSK and therefore the units of the model space are meters. The 

required content will be printed on and A3 drawing in a scale of 1:5,000, the display will be rotated 

according to the new coordinate system created by the procedure described in chapter “Creating 

a new coordinate system”. At the same time, a viewport will be inserted into the drawing, with the 

display of a clear situation in a scale of 1: 20,000 oriented according to S-JTSK. 

Two viewports will be used: 

- the viewport of the detailed situation in a scale of 1: 5,000 with a rotated coordinate 

system, 

- the viewport of broader relations oriented according to S-JTSK in a scale of 1: 20,000. 

For the viewport of the wider relations, the UCS “World” will remain as the current 

coordinate system. The scale for drawings prepared in units other than millimetres is simply entered 

as “Custom scale” into the property field of the viewport according to the formula XXX/MMMxp. 
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XXX means the conversion from the units of the model space to millimetres - from meters to 

millimetre this value is 1,000 (1 m = 1,000 mm). MMM means the scaling number. In case of a 

wider situation for the scale 1:20,000, the entered value is “1,000/20,000xp”. The viewport set like 

this  can then be locked. 

For the viewport of the detailed situation, first the rotated coordinate system is selected as 

the current one, and then the scale is set based on the same principle as for the wider situation, and 

the scale is 1,000/5,000xp. 

The drawing (Fig. 124) prepared in this way can be supplemented by the required notes, the 

layer settings can be edited, etc. 

Fig. 124: Situation drawing of the Radošinka stream 
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Creating the scripts 
In fact, the work on the particular projects is unique, but routine tasks requiring a repeated 

work flow are common during the project works – for example, multiple insertions of a block and 

defining its attributes to different locations with different values of these attributes, importing the 

geodetically measured data (border of the land, watercourse, etc.) or other sequence of steps. The 

script is a text file containing the record, or the succession of the tasks and the used values that are 

performed in the order in which they are written in this file. The script file can be created from the 

*.txt text file to the *.scr file by renaming or by changing the suffix. The content of the file consists 

of a text containing commands and entered values as they would be entered in the command line. 

A simple preview of the script is the creation of a line from the point [10,20] to the point 

[50,100] and then the subsequent setting of the display so that all entities in the drawing are 

displayed in the drawing window, in this case only this line. 

When working without a script, the procedure would be as follows: 

1. using the command to draw a line (click on the icon, select in the drop-down menu, or

enter the command “_line” in the command line)

2. entering the starting point of the line as the absolute coordinates [10,20] entered in the

command line

3. entering the end point of the line as the absolute coordinates [50, 100] or as the absolute

coordinates [@40,80] entered in the command line

4. stopping the command to draw a line (press the “Enter”, “Escape” button or the space

bar)

5. using the command “ZOOM” (click on the icon, select in the drop-down menu, or enter

the command “_zoom” in the command line)

6. selecting the option to zoom in on all objects in the drawing (select the keyword

“Extens” in the command line or enter the value “e” in the command line)

Note: The commands are given using the underscore, as in the case of language mutations in 

the AutoCAD program, there are also changes to the names of the individual commands. In the case 

of the Czech language mutation, the command for the drawing of the line is “ÚSEČKA” and 

therefore the English command “LINE” will not work. But if we use the underscore and the English 

name of the requested command, this command will work in each language mutation.  
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This entire procedure, which is only entered through the command line, is as follows: 

1. _line↵

2. 10,20↵

3. 50,100↵

4. ↵

5. _zoom↵

6. e↵

The entry in the form of a script can therefore be done in a very similar way, or it can be 

done in a more structured form, where the design of a line will be done in one row, and the second 

row will be there for the setting of the zoom-in. In case of scripts, it should be noted that the 

confirmation of a given command or value can be done with one of two characters – using a space 

or a new row (Fig. 125). Subsequently, it is necessary to change the file extension from *.txt to *.scr. 

Fig. 125: Options for structuring the content of the script file. Entering the particular input data always into a new 
row (on the left); entering the particular work steps into the rows for a complete steps; 1 – first row ending with a space to 

confirm the entered coordinates of the end point. 

Using the script is done using the command “SCRIPT” or using the “Applications” button on 

the “manage” tab (Fig. 126) and selecting the respective *.scr script file we want to use. 

Fig. 126: Using the script from the “Application” panel on the “Manage” tab; 1 – button to use the script 
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After the script is started, all the actions defined in the file with the currently set parameters 

of the program are performed (layer, colour, line thickness, etc.). When creating a drawing using 

a script, when the script also contains the required coordinates, or the angles and dimensions, it is 

advisable to turn off the modes for the use of the grab points and tracking (OSNAP – F3; 

AUTOTRACKING – F11), since the entering of the coordinates could use snapping and tracking 

with the turned-on modes which would change the required geometry defined in the script. 

Creating the path from the geodetic measurement 

In the practice of landscape planning, we can normally encounter tasks requiring the 

drawing of geodetically measured objects. In general, we can say that there are a series of points 

that can form separate point objects (e.g. planimetry, topography), line objects (e.g. shore line, path 

axis), or area objects (e.g. building, plot). Nowadays, the software for the work with geodetic data 

nowadays normally allows the export of measured data in the format used in the CAD programs 

(*.dxf or *.dwg files), but it is still possible to encounter data in the form of a text describing the 

coordinates and various attributes of the measured points. 

In case of the Radošinka stream, the axis of the road between the villages of Zbehy and 

Čakajovce was measured. The points at the top of the road in the direction Zbehy – Čakajovce were 

geodetically measured and the coordinates and ordering numbers for the measured points in the 

format of a *.txt file were used. (Fig. 127). 

Fig. 127: Sample of the file with the measured points of the road axis between the villages of Zbehy and Čakajovce 

It would be rather lengthy to manually create a route of the road axis from the measured 

points (by specifying the coordinates of the measured points in the command line), so we can use 

the option of creating a script that creates the lines automatically. To create a script, we first import 

the measured data into the spreadsheet program (MS Excel), where we process them into the 

desired form. 
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First, we modify the S-JTSK coordinates for the use in the CAD environment – we 

interchange the axes X and Y and enter the values in the negative format (see chapter “S-JTSK 

coordinate system in the AutoCAD environment”). Then we create the contents of the script file, 

where we enter a line creation command in the first row and in the other rows the coordinates of the 

measured point will be specified. Since the point name – number rises in the order of the 

measurement, the next point is always the following point of the road axis. Creating a pair of 

coordinates separated by a comma is solved by the “CONCATENATE” function, which combines 

the contents of the cells, or ext data – in our case, the cell with the coordinate X, the text containing 

the comma, the cell with the data of the coordinate Y (Fig. 128). 

Fig. 128: Creating the script text in MS Excel, 1 – formula for linking the cells with the coordinates and the text 
containing a comma; 2 – column “I” containing the script text 

Behind the row of the coordinate of the last point, it is necessary to enter two characters 

(two spaces, a space and a new row or two new rows) because we need the program to make two 

confirmations – for the first time to confirm the last coordinate and for the second time to confirm 

or to end the command for the line design – the equivalent of pressing the “Enter” key (Fig. 129). 

Fig. 129: Script for creating the design of the of the measured top of the road; beginning of the file (on the left); end 
of the file (on the right); 1 – two empty rows for two confirmations of commands or values 

Then we change the file extension and we can start the script. In case of the Radošinka 

stream, we can start the script directly in the drawing, which will create the design of the measured 

top of the dam directly on the background of this drawing so as the currently set program (Fig. 130). 
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Fig. 130: Road created from the measured top of the road; road created from the lines using the script from the 
measurement (green); road created from the original documentation (red) 

Using this script, we created 3é lines between 31 points that had been geodetically 

measured. Since, in case of the line lines, the use of continuous lines (”Polyline” type entities) is 

more appropriate for the progress of their individual parts (axes, shores, road shoulders, etc.), the 

script can be changed because the creation of the continuous line is very similar to the the creation 

of the lines (keyword – node coordinates - completion of the command) – it is enough to change the 

keyword “_line” “_pline” and the resulting drawing will be a continuous line crossing the 

geodetically measured points. 

Inserting the blocks and filling in the attributes using the script 
With scripts, it is possible to insert blocks with attributes, but the script structure needs to be 

changed. Since some commands in the AutoCAD program work with a dialogue box where we 

performs the settings or properties, it is necessary to use commands in the scripts in a way that 

solves the use with entering the parameters using the command line without opening their dialogue 

boxes.  

Starting a command by suppressing the dialogue box and entering the input using the 

command line is solved by entering the command with a hyphen before the keyword, e.g. the block 

insertion is performed with the command “-INSERT”. 

Note: This function works for a large number of commands, but not for all, so when using 

scripts, it is good to first verify the functionality of the required command without a dialogue box 

before creating a script. 

Another change is the confirmation of attribute input. Since when we use attributes, it is also 

possible to enter text data containing a space, it is necessary to confirm the input of the attribute 

value in a different way. Since the use of a spreadsheet editor for script creation is based on the one-
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row principle for executing a single command (block insertion and attribute input), it is also not 

appropriate to use this method. Therefore, as a character to confirm the attribute input we use 

a special character, the so-called carriage return, whose Unicode character is “\U+000D”. 

The possibilities of this solution will be demonstrated in the situation of the Radošinka 

stream, where a dendrological survey was carried out with a geodetic measurement of the trees 

position. The survey results were delivered in the form of a set of coordinates and attributes for the 

individual trees. Then it is necessary to draw the location of the trees and individual attributes in the 

drawing.  

For these purposes, we create a block of attributes (Fig. 131) consisting of a schematic tree 

display and four attributes for the particular parameters of each tree. 

Fig. 131: Tree block with attributes (tree umber, height, trunk perimeter, tree-top perimeter) 

Then, in MS Excel, we process the provided data (Fig. 132) to create a script that 

automatically inserts the tree block into its real location and fills in its attributes according to the 

dendrological survey.  

Fig. 132: Data provided by the dendrological survey and the geodetically measured coordinates of the position of 
trees 
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Starting the command for inserting a block named “tree_description” and filling in the 

attributes is solved by the following order of entered parameters: 

1. -insert↵

2. tree_description↵

3. coordinate_X,coordinate_Y↵

4. scale_x block ↵
5. scale_Y block ↵
6. angle of block rotation↵

7. tree number↵

8. tree height↵

9. trunk perimeter↵

10. tree-top perimeter↵

11. type↵

12. “OK” button

The script will then be created in the way that the insertion text of one tree block and the 

filling-in of the attributes will be performed by using the “CONCATENATE” function, from the 

provided data and required block parameters (scale, block rotation angle) for the first row, and then 

applying it for each row and therefore for each tree according to its parameters (Fig. 133). 

Fig. 133: Script for inserting a tree block with attributes and entering the attribute values without using a dialogue 
box, 1 – starting the command and entering the block name; 2 – entering the input coordinates with the conversion of 

geodetic coordinates for use in the AutoCAD program; 3 – entering the scale in the X and Y directions and entering the block 
rotation angle; 4 – entering the attribute value and the confirmation using the Unicode character “carriage return”; 5 – cell 

containing the Unicode character “carriage return” to simplify the work 

The last attribute will only be confirmed by inserting a new row without using the Unicode 

character “carriage return” because starting a new row will terminate the block insertion with 

entering the value of the last attribute. 

The script created in this way can then be run for inserting and filling in the attributes from 

the provided documents (Fig. 134), which, in case of large-scale projects, will greatly simplify the 
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work because it is not necessary to insert and fill in each block individually. This will make the 

operation much shorter and eliminates the possible errors that occur when you manually enter the 

attribute values or the position of the block insertion. 

Fig. 134: Resulting dispaly of several trees with attributes filled in according to the dendrological survey 
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